Melvyn's Music Roll and Organ Book
Editor
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Introduction
The Music Roll and Organ Book Editor is a sophisticated program designed to enable music rolls and other forms of
mechanical music to be written and edited in much the same way as a word processor is used to edit text. This
program was first published in 1988, and was the first computer editor designed specifically for editing music rolls
and organ books. This was before the use of the PC or MIDI in the consumer marketplace, so it was written entirely
in Machine Code for an 8-bit Amstrad home computer. At that time, all music rolls and books were drawn out
laboriously with a pencil and square on a composer's plank or a barrel, so this program caused quite a sensation at
the time, as it completely revolutionised the process. It also made it possible to hear the music whilst it was being
created, without having to punch out a music book (full of mistakes), find an organ to play it on, and then correct all
the mistakes and do it all again! It was featured in a 1988 edition of The Key Frame magazine.
I have been using this program to write all my music for the past 25 years! It has been used to create thousands of
pieces of music for mechanical organs, by me and many other professional arrangers. Unfortunately, I have never
been able to find the time to convert the program to run on a modern PC, despite the many desperate pleas for me to
do so! But now that my original computer equipment is on its last legs, I have finally managed to re-write the
program to run on Windows, and to make a number of significant improvements at the same time.
The Editor presents a graphical display of the music roll on the screen. This may be scrolled up and down the screen
as required, and 'holes' may be punched or deleted by simple key presses. Once the music is finished, the program
will produce a MIDI file which can then be used to print out a music book, operate an automatic punching machine,
or play the organ directly. It can also produce Harmonist files. The original program could print out a music roll
directly on a dot-matrix printer, but this was thought to be unnecessary now that most music is punched out on
automatic machines, and free software is also available which will do a roll printout from a MIDI file, for those that
need it. See Music Roll and Book Printouts.
Music editing uses the computer keyboard rather than a mouse, and is extremely fast once learnt. Whole notes, and
even trills, can be inserted with a single key press, and whole melody lines and chords can be created in just a few
seconds. Many functions are provided to help speed up the editing of the music. Drum rolls require just one long
continuous note.
The program is an organ simulator as well as a music editor. So it will read your music and play it in exactly the same
way as the organ will play it. In other words, all the register and percussion controls in your music will be interpreted
in exactly the same way as on the real organ. Registers can be set by the bass drum, and the side drums can even
switch over to wood blocks when certain registers are selected. Scrambled scales are completely eliminated. All
editing is done with the keys arranged in a logical order across the music roll. If any scrambling is required it will be
done automatically by the computer before the final music is produced.
All the normal word processor-type commands are featured, including block move, block copy, block delete, search
and find, etc. It is also possible to tell the computer which sections of the music are to be repeated, thus eliminating
the need to enter them twice. The computer can be instructed to vary the tempo of the music at any point in the roll,
this allows subtle tempo changes to be made without affecting the length of the holes on the screen. The basic time
unit of the Editor is 1/20th of a second (although there is also a High-Speed mode), so it is impossible to write music
which is too fast for the organ to play.
Noteur's comments and bookmarks can be inserted anywhere in the music.
Because of the program's DOS ancestry, all editing can be done from the keyboard without using a mouse. This may
not be what you are used to, but is a great deal faster. Despite the program's initial 'clunky' appearance, nothing has
surpassed this Editor for the specific purpose of creating music rolls and books for mechanical organs.
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Important: This is not a General-Purpose MIDI Editor
Because of the program's history, it is not really designed to be a MIDI file editor. It is a program for arranging or
composing music from scratch, which will then produce a MIDI file of that music. The program was never designed
to work with existing MIDI files (they didn't even exist when the program was first written!) A facility to import
MIDI files has been included, but you should not use this program for the general editing of MIDI files. There are
many aspects of MIDI which are irrelevant, and even undesirable, to mechanical organs, so these are deliberately not
supported by the Editor. For instance, MIDI music can have a repetition rate which is far greater than any human or
mechanical instrument can play, and it can also include illegal notes, duplicate notes, and overlapping notes which will
produce errors and unexpected results on an organ. For example, you can switch the same note on 5 or 6 times and
only switch it off once - how is an organ supposed to react to that? Because these features are deliberately not
supported by the Music Roll Editor, you can be sure that any music you write with it will play properly on an organ.
This is not the case when using a 'normal' MIDI editor to write organ music.

Features
* System completely replaces the traditional composer's plank and drawing board
* Vertical display of music roll, just like a player piano
* No screen clutter! You just see the music roll, and nothing else!
* Create and edit music by using just the cursor keys and space bar
* Straightens out scrambled scales
* Produces MIDI files and Harmonist music. (MIDI files can be used to produce rolls and books, etc.)
* Everything appears on the same screen - including Counter-Melody, Percussion, Tempo, Registers, etc.
* Music can be played and tested during arranging
* 8-channel sound output simulates all pipework, Percussion, Bass Helpers, etc.
* Any organ scale up to 64 keys
* Notes missing from the organ do not appear on the screen
* All normal word processor-type options included: Block move; block copy; block delete; fast searches; etc.
* Serial and Chord editing modes
* All registers and percussion are controlled from the music roll in the same way as on the actual organ
* All types of register control systems catered for: Set/Cancel, Declanche, Continuous hole, Harmonist, etc.
* Pipework and registers are all user-defined, for maximum versatility
* Includes automatic section repeats (macros)
* Rolls or parts of rolls can be merged into each other
* Noteurs' on-roll comments, bookmarks, and references
* Automatic drum rolls, trills, tremulant and octaves
* Automatic drum and cymbal advance
* Automatic checks for errors in the music roll
* Adjustable tempo and timing scales
* Will not allow notes or timings to be entered which are not playable on the organ
* Will transpose and convert music from one organ scale to another
* Can import MIDI and Harmonist files
* Constant display of duration and length of roll
* Customisable audio
* An assortment of organ scales supplied, ready to use
* Approx. 50-page e-manual and Help system, including a MIDI primer and MIDI reference tables
* The program is portable and does not need installing
* Many more features too numerous to mention!
Features in italics are not included in the Trial Version. The Trial Version can hold up to 1 minute of music
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Contact me to upgrade to the Full Version
System Requirements
The program was developed on Windows XP with 2GB of RAM. Obviously, I do not have sufficient resources to
test it on PCs with every combination of hardware and software. I believe it should work on most modern PCs. It
might work on Windows 95 for all I know!
If you have problems running the program please contact me.
You will need to have a screen display of at least 1024 x 768 pixels, which is quite low by today's standards. The
program runs in a window of 720 x 576 pixels, so if your screen size is a lot higher than this, the window will appear
smaller.
One thing that needs mentioning is that the PC should have fairly fast graphics capabilities. However, exactly what
this means is not certain because I have found that the program runs quicker on my 1.7GHz laptop than it does on my
2.8GHz desktop PC! Neither has a dedicated graphics card, and they both have the same amount of RAM. I have
recently bought a cheap entry-level PC with a 3.2 GHz Dual Core processor, and it runs like lightning on this, so it
should run alright on any modern PC, however cheap. All I can say is that, if the program runs too slowly on the
small screen option, then try a faster graphics card or get a new PC!
You will, of course need a MIDI sound card, but almost all PCs now come with this built-in anyway. Whether you
wish to get a more expensive one or not will depend on what the quality of the internal sound card is like. Some are
atrocious!
You may need a decent speaker system as well. It is really up to you, how much you want to spend and how serious
you are about writing music. See possible problems.

Getting Started
The complete software package consists of the main Editor program (MusicRollEditor.exe), the README.TXT file,
and some example scale files (.cfg).
The program does not need to be installed. It is simply run by double-clicking on the MusicRollEditor.exe file, but if
you are going to use it seriously I would suggest you do the following first:
Create a new folder called Music (or something similar). Unzip the attached file(s) and move all the files into the
folder. If you have bought the Full Version of the program, your 'upgrade.key' file must also be stored in the same
folder. This file is unique to you.
If you are only writing music for one organ, this should be sufficient. If not, create individual sub-folders to store the
music for each scale you do (31Raffin, 48Keyless, etc), and another sub-folder called Scales. The Scales folder is
for storing all your different organ scales. If required, create a sub folder in the Scales folder for Conversion Scales.
Double-click on the MusicRollEditor.exe program to run it. When the program is run, it will create additional files:
Config.exe, DemoMusic.mus, EditorHelp.chm, InitialScale.cfg, Import1to64.cfg, and InstructionManual.pdf.
You can create a Desktop shortcut to the Music Roll Editor in the usual way, by right-clicking on the
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MusicRollEditor.exe file and selecting 'Create Shortcut' or 'Send to Desktop'.
You can also arrange for the program to run automatically when a music file is clicked. Do this by double-clicking on
ANY .mus file, and a box should appear asking you which program you would like to associate with that file. Select
the MusicRollEditor.exe file and press OK. Now, whenever you double-click on any music file it will automatically
run the Editor program and load in the music.
When the Music Roll Editor starts up, Press f1 for the Help Screen.
Note that you can select a larger or smaller screen size from the Options menu, the smaller screen size will speed up
the program slightly. You will find that it is not possible to resize the window. This has been disabled because it
offers no advantage. It just creates a larger border around the display!
See Music Editor Basics to familiarise yourself with the Editing process.
If you are an existing user of the Amstrad version of this program, you should read the notes about using your existing
music roll files with this new Windows version.
The types of files used and generated by the Editor are as follows:
Music files (.mus)
Scale Config files (.cfg)
MIDI files (.mid)
Harmonist files (.har)
Part-Music files (.prt)
Register Def. files (.rdf)

These are the main music roll files and also contain details of the organ scale, registers, etc.
These contain all details of the configuration for each organ scale
Standard MIDI files
These are music files that will play on Pell Harmonist / Mini-20 organs
These contain part-music files to be merged with other music rolls
These contain the definitions and functions of the 32 register keys. (Unfortunately .reg is already be
used for Windows registry files!)

Scale Configuration files (.cfg) are used by the Editor to configure it to each individual organ, or organ scale. These
are created using the Scale Configuration program (Config.exe). Before any music can be written on the Editor, you
will need to load the appropriate Config file into the Editor to tell it what organ scale you are working on. When you
save your music, the Config file will also be saved within the music file, so you do not need to pre-load a Config file
when working on existing music. Everything is contained within the music file.
Each time the Editor starts up, it loads in the InitialScale.cfg file which sets it up to work with a particular organ scale.
If you would always like it to start up with your favourite organ scale instead, you can create your own scale and
name it myscale.cfg. Make sure this is stored in the same folder as the main program, then the Editor will start up and
load in your scale instead of InitialScale.cfg.
Virus Warnings!
You may or may not get a virus warning and all sorts of other warnings of doom from your anti-virus program. I can
guarantee that there are no viruses, spyware, malware, or other harmful effects in my program, and it
does not even access the Internet or install itself in your computer. (The only thing that accesses the Internet
is this Help Reader, and this is a Microsoft program!) Viruses are written by anonymous people, not by somebody
who puts their name to a program! If you do get such a warning, it is simply because your anti-virus program does
not recognise my program (hardly surprising really!). It is quite common for anti-virus programs to assume that all
unknown programs are harmful, just in case they are. Most anti-virus programs have a facility whereby you can tell
them to ignore a trusted program.
To Uninstall or Transfer the Program
As the program is not installed it is completely portable. To 'uninstall' the program, just delete it! If you want to
transfer it to a new computer, simply transfer the files to the new computer!
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Music Editor Basics
When you start up the Editor you will see a display of a blank music roll on the screen, ready to enter new music, or
load a music file. You can change the start-up scale. You will see the organ scale across the top of the screen and
the timing marks down both edges. The music is presented on the screen from top to bottom, so that the notes at the
top of the screen will be played first. This is the opposite direction to a Pianola, but it is much more natural to read
the music from top to bottom rather than bottom to top! The flashing cursor indicates the current editing position, and
the horizontal position of the cursor is also indicated by the big red arrow which moves across the scale at the top of
the screen. So the arrow points to the current note being edited.
Pressing the 4 cursor (arrow) keys will enable you to move the cursor to any position on the music roll in order to
punch or delete holes at that position. There are a large number of options for moving the cursor quickly to any part
of the roll, these will be described later.
Try moving the cursor around, and 'punching' some holes by pressing the Space bar. Hold it down until the note is as
long as you want it. Moving the cursor across the roll also moves the red arrow across the scale at the top. As you
enter a new note, the cursor automatically moves down the roll so that holding down the space bar will produce a
long slot for a continuous note. Long slots are made up of a number of small dots, these coincide with the timing
marks down the edges of the roll to enable you to easily determine how long a note is. Notice that the editing
position is just below the line across the middle of the screen, and this is where all editing takes place. You can click
anywhere on the roll with a mouse and it will bring that position to the editing position. You can also use the scroll
bar on the right-hand side of the screen to move to any position in the roll. The frame number at the bottom of the
screen will tell you exactly where you are in a roll.
The beauty of the program is that, in theory, you can create any piece of music just by using the 4 cursor keys and the
space bar, and you don't really need to learn anything else! All the other keys and features are mainly there to speed
up the process considerably and to automate various tasks.
The editing position can be moved up or down the screen by pressing the F5 and ctrl+F5 keys. The purpose of this
is to allow the editing to be carried out nearer the top or the bottom of the screen. Moving the cursor line up the
screen allows more of the roll to be seen ahead of the editing position, and vice versa.
Move the cursor to a note on the scale and press P. You should hear it play. Press P again to switch it off. You can
play up to 3 notes at once like this, in order to try out different chords. Press the Esc key to switch them all off.
You will notice that you can move the cursor outside the left-hand edge of the roll, where it will appear underneath a
number of yellow 'Command' functions. These allow special functions to be performed, and will be described later.
The Editing Commands
Pressing F1 will print a Help Screen, listing the keyboard map, and all the editing functions available. The key to fast
music editing is in the use of the keyboard rather than a mouse and pointer to enter information, which is often
laboriously slow and tiring (imagine trying to write a letter without a keyboard, and having to select each letter
separately with a mouse). To make the most of this, you will need to learn the basic key functions, but these are
mostly all logical.
When the editor is first loaded, the blank music roll is approximately 500 frames long. When you have filled these
frames press Enter or ctrl+Enter to create new frames as required. If you are only writing a short piece, the spare
frames at the end can be deleted with the F7 key. The Status Bar at the bottom of the screen tells you what frame
number you are on, the duration of the music, and the total length in metres.

Created with the Freeware Edition of HelpNDoc: Easy CHM and documentation editor

There is an example of a finished music roll in the supplied files. In order to see this, press ctrl+F12 to load it in.
When it has loaded, you will be able to see it on the screen, and press shft+Tab to play it.

General Editing Keys
Music is written using the keyboard rather than the mouse to enter notes and move around the screen, etc. It is much
faster to use two hands and 40+ keys than to use a single hand and a mouse! This page describes the function of
each of the keys used to edit the music roll on the screen. You will need to learn most of these, but they have been
made as logical as possible, and are based on common Word Processor key functions. These key functions are also
listed on the Help Screen (Press F1).
Note that on some laptops the ctrl+F1 to ctrl+F12 keys are sometimes used for internal functions like
volume controls, music playing, etc. If this causes problems, then try using shft+F1 to shft+F12 for the
Music Roll Editor. In many cases, the shft and ctrl keys will do the same thing.
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Navigational Controls
Up, Dn, Left, Right
ctrl+Left, ctrl+Right
PgUp, PgDn
Home, End
ctrl+PgUp, ctrl+PgDn
ctrl+Home, ctrl+End

Move cursor one step in that direction
Move to extreme left or right edge of roll
Move up or down 2 whole timing divisions
Move to Home/End of this section (Reference line)
Move to next or previous marker
Move to extreme start or end of roll

Punching And Deleting Holes
Ins
Del
Space

Punch a single hole and advance
Delete a single hole and advance
Toggle a single hole and advance (this is the main editing key)

Punching And Deleting Whole Notes
BkSp
Delete whole note
Numbers 1 - 8
Insert a whole note of that length, and advance to end of note
Creating And Deleting Frames
This is equivalent to inserting or cutting a piece out of the middle of the roll.
Enter
Insert blank frame (shift everything down to make room)
ctrl+Enter
Insert whole timing division (usually 8 frames)
ctrl+BkSp
Delete whole frame (shift everything up to close the gap)
Other Editing Keys
X key
O key
T key
F key
P key
S key
C key
Play Keys
Tab
Q key (next to Tab)
shft+Tab

Extend all notes in the previous frame to this one, and advance
Copy this note to an octave above (if available) and move to end of note
Insert a trill on this note for one timing division, and move to end of trill
Find the next instance of this note (search function)
Play this note. Up to 3 notes can be played simultaneously. Press Esc to stop.
Serial Editing mode (see other section)
Chord Editing mode (see other section)

Play music from Reference line
Play music from cursor
Play music from start
Press Esc to stop play. See the Play menu

Hints for Speedy Editing
The ctrl key is very rarely needed for navigation unless you need to find a bookmark. You can step through most rolls
in just a few seconds by use of the Up, Dn, PgUp, PgDn, Home and End keys.
Use of the Space bar allows holes to be both created and deleted, which is usually the fastest way to work.
The Number keys allow you to quickly enter whole melody lines with just a few key presses (try it!). Press C for
Chord mode and the Number keys now enable you to rapidly enter complete chords.
With the X key, you can extend single notes or whole chords with a single key press.
The O key is perfect for expanding tunes to a larger scale, especially when used with the F key.
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The F key can save you a lot of time in searching for notes. For instance, it is very useful for finding and removing
notes when converting music to a smaller scale.
The P key is a basic facility for testing notes and trying out various chords before putting them into your music.

Editing Modes
Serial and Chord Mode
The Editor has two modes of note entry: Serial mode and Chord mode. The Editor starts up in Serial mode, but can
be switched to Chord mode at any time by pressing the C key. Pressing S will switch back to Serial mode. The
Status Bar at the bottom of the screen will tell you which is the currently-selected mode.
In Serial mode, whenever you insert a hole or a note, the cursor will automatically advance to the end of the note, so
that it is in position to accept the next note in the sequence. This saves a lot of time and key presses, but it is not so
convenient when entering chords, as it means you have to step back to the beginning of the note again before you can
enter the next note of the chord.
The Chord mode switches off the automatic advance, so that the cursor remains at the start of the note just entered,
instead of jumping to the end. This allows the quick entry of chords, and notes which are side-by-side.
The Serial and Chord modes are most useful when using the Number keys (1-8) to enter whole notes. Whole
melodies or chord harmonies can be entered very quickly using these techniques.

Frames Timing Marks and Tempo
You will see that the music roll is divided horizontally by a number of major timing divisions appearing regularly
across the width of the roll. To understand these it is necessary to introduce the concept of 'Frames'. A frame is a
complete horizontal row in the music roll which occupies a single unit of time. Put simply, each horizontal row on the
roll is a frame.
The small timing marks down the edge of the roll indicate the frames, and a single dot in the music lasts for the
duration of 1 frame when the music is played back. This is the shortest note possible. It is possible to set the tempo
(speed) of the music so that each frame represents any unit of time required. In this way, the tempo of the music can
be set independently of the length of the holes in the roll. Therefore, when starting on a new piece of music, you
should decide on the length of the shortest note in the piece and use a single frame to represent this length of note. All
other notes then become multiples of this length. The tempo of the music is then set using Tempo commands (see
later) so that the music plays back at the correct speed. The tempo can be changed at any time during the roll.
The major timing divisions across the screen enable the notes to be easily aligned with each other, and to the beats of
the music. These lines appear regularly across the screen, and serve to divide the music up into beats or bars,
according to the arranger's preference. It should be understood that these timing lines are merely provided as a visual
alignment aid. They do not affect the music itself, or the way the Editor plays the music.
By pressing the F4 and ctrl+F4 keys you can set the timing lines to appear at any frequency you wish, depending
upon the time signature of the music. For example, a march in 4:4 time would normally be divided across into
8-frame units, making each division represent a minim. Each frame therefore, represents 1/8th of a minim which
equals a semi-quaver. Similarly, a waltz in 3:4 time could be divided up into 12-frame or 6-frame units. Some
marches in 6:8 time are best divided up into 9 units. Don't worry about this if it seems a little complicated. Unlike a
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composer's plank where you must establish the correct timing scale right from the start, the Editor allows you to
change the timing scale at any time you wish. Therefore you can start writing the music and then adjust the timing
marks to fit in exactly where you want them after you have completed a few bars. You will normally find that it is
best to divide the music up at every major Bass note.
If you are writing a piece of music which has several time signatures in it, you just adjust the timing divisions to line up
with the section you are currently working on, using the F4 key
There is more about tempo and the Tempo command in The Editing Commands section.

The Editing Commands
These commands appear down the left-hand side of the screen, underneath the yellow headings. The commands
themselves do not appear in the finished music, but are used by the Editor to modify the music at that point in some
way. Commands are entered and appear on the screen in the same way as ordinary musical notes, they are just
interpreted differently by the Editor. Some of the commands require a frame to themselves, whereas some can be
used on the same frame as normal musical data. There are 6 commands altogether, labelled S, M, T, R, J and D.
(The J and D are never needed on modern PCs with lots of memory.)

S - START Command
A dot in this position tells the editor that this is the start of the music. In all of the music output modes (play, compile,
etc.) the editor does not necessarily start from the beginning of the music. You may only want to play the section
which you have just completed, in which case you could place an S command at the beginning of the section and the
Editor would ignore all the music before that line.
Adding additional S commands allows you to test your work from strategic points in the music as you go along.
There must be at least one S command in each piece of music, which will normally be at the beginning of the roll. If
there is more than one S command the Editor will start from the one nearest to the end of the music. Pressing
ctrl+F3 will remove all spurious S commands and reinstate a single S command at the beginning of the roll.
M - MARKER Command
A dot in this position sets a marker (bookmark) at that point in the roll. Markers are used for a number of the more
advanced editing options, such as Block Move and Block Copy, but they can also be used as simple bookmarks.
You can step instantly to any marker by using the ctrl+PgUp and ctrl+PgDn keys. By setting markers at strategic
points in the roll, you can return immediately to these points without having to search for them. This is useful when
comparing two similar sections in the music, as you can step instantly between the two points, and any differences
become obvious. Markers are placed on the frames to which they refer, they do not need a frame to themselves.
The markers do not affect play in any way. Pressing F3 will remove all markers.
T - TEMPO Command
A dot in this position defines the tempo of the music from that point onwards. It is a feature of the Editor that the
tempo of the music can be changed at any point in the roll. Therefore, there may be any number of Tempo
commands in a piece of music. The T command requires a frame of its own, so to insert a T command first create a
blank frame (press Enter) at the point where you wish to change the tempo. Then insert a hole on the blank frame,
underneath the yellow 't' in the 'Commands' section of the screen to tell the Editor that this is a Tempo command.
The rest of the blank frame (inside the music roll) is used to tell the Editor of the new tempo you wish to use. So
starting from the left-hand edge of the roll, insert a row of holes extending towards the right-hand edge of the roll. The
number of holes in the frame (ie, the length of the line) indicates the new tempo. The Editor works in 1/300th of a
second time units, starting at 15/300th of a second (15/300ths = 1/20th second). Therefore 0 dots is the fastest, and
will cause each frame to last 15/300ths of a second; 1 dot = 16/300ths of a second; 5 dots = 20/300ths of a second;
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etc.
When the editor is first loaded, you will see that the tempo of the blank roll is set to 15+5 = 20/300ths (or 1/15th) of
a second. In practice, there is no need to work out the values like this, you just set the tempo up by trial and error,
making minor adjustments until the music plays at the correct speed. You should note that the starting tempo for a
piece of music need not necessarily appear at the start of the roll (although it makes sense to put it there). When
playing or compiling the music, the Editor will set the initial tempo up to the tempo of the section that is to be played.
This enables the S command to be moved about without having to insert new T commands each time. Once the
music is playing, all additional T commands will have an immediate effect as they are encountered during play. There
must be at least one T command in every piece of music..
R - REMARK Command
A dot in this position simply causes all the music on that frame to be completely ignored by the editor. At first this
appears to be a pointless facility, but it allows the arranger to place remarks or reference points on the roll, and as
such is invaluable. Without such points of reference it would be very difficult to keep track of your position in the
music, or to identify a particular passage.
The simplest form of reference is a single frame consisting of a complete row of holes. This has the effect of drawing a
line across the roll to split it up into sections. At the major divisions in a piece of music, it is usual to create a number
of blank R lines and to 'punch' holes in the roll to form a message identifying the section (PT 1, PT 2, PT 3, etc.).
Remember that an R command causes the music in the frame to be ignored completely, so you can use these lines for
any purpose you choose. This means that a long slot in the music may be split up into two smaller slots by a group of
R lines passing through the middle, and it will still sound as one continuous note.
Although all musical data on an R line is ignored, any other commands on these frames are still obeyed. This means
that, for instance, you can still start the music playing from an R line, and still place markers on these lines. Use the
F2 and ctrl+F2 keys to quickly insert reference lines in your music, or divide it up into sections. The Home and End
keys are used to step rapidly through the sections of your music
.J - JUMP Command
A dot in this position causes the editor to jump to a Repeat Section in the music. Like the T command, the J
command is placed on a blank frame and requires a number of holes within the music roll to represent a number. This
facility will be described later.
D - DEFINE REPEAT-SECTION Command
A dot in this position defines this line as the start of a Repeat Section in the music. The D command requires a blank
frame, and is usually placed on the reference line at the start of the passage to be repeated. Repeat sections are
described later, in a separate section of the manual.

The Function Keys
The functions provided on the F keys are as follows. Most of them have already been explained:
Help Screen
Pressing F1 will print the Help Screen, listing all the keyboard functions. Press any key to return.
Reference Lines
Pressing F2 will create a blank frame at the cursor and then place a single reference line of holes on that frame, useful
for minor divisions in the music.
Ctrl+F2 will create a major reference division, and should be used at the start of every section of the music. The
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number of blank frames created will be exactly equal to the number of frames between timing lines. This is so that the
music above and below the reference will both still be in alignment with the timing lines across the roll. In addition to
this, the top and bottom lines in the reference division will both be filled with a line of holes, leaving the centre section
blank for you to fill in your own comments.
Remove Unwanted Commands
Pressing F3 will delete all markers. It is recommended that you use this key to delete all previous markers before
using any of the Block Delete or Copy functions (F7-F9). All of these functions require two markers to be set in the
music before use. If more than two markers appear, then only the first two markers in the roll will have any effect.
Pressing ctrl+F3 will remove all spurious S commands and reinstate a single S command at the beginning of the music
(which may not be at the top of the roll).
Timing divisions
F4 and ctrl+F4 are used to increment and decrement the frequency of the timing divisions across the screen.
Editing Position
F5 and ctrl+F5 will move the editing position up and down the screen.
Manipulating Whole Sections Of The Music Roll
Pressing F7 will delete the entire section of music between the two markers. This includes the marked lines
themselves.
Pressing F8 will move the section between the markers, including the marked lines, to the position of the cursor. The
section will appear immediately after the cursor frame. and all the music which was originally in that position will be
moved up to make way for it.
Pressing F9 will copy the section between the markers, including the marked lines, to the position of the cursor. This
is the same as F8 except that the original passage is not deleted, thereby creating two copies of the passage in the
roll. This is the standard method of implementing repeats in the music.
Operations On A Single Key Throughout The Music Roll
ctrl+F7, F8 and F9 are equivalent to F7, F8 and F9 but operate on single keys:
Pressing ctrl+F7 will delete all the notes on the currently-selected key in the music.
Pressing ctrl+F8 will move all the notes on the currently-selected key to another key. The new notes will be merged
with any existing notes on that key. If this is not what you want, then first delete the existing notes with ctrl+F7.
Pressing ctrl+F9 will copy all the notes on the currently-selected key to another key. This is the same as ctrl+F8
except that the original notes are not deleted, so the notes will appear on both keys. Again, the new notes will be
merged with any existing notes on that key.
Loading Music and Scale
Use ctrl+F11 to quickly load in a new Scale Configuration file. This will replace the scale already in memory.
Use ctrl+F12 to quickly load music into the Editor. This option loads a complete music roll, and its associated Scale
Configuration into memory. Any music and/or scale data that was already in memory will be overwritten. (ctrl+F12
is a standard method of loading files into word processors, etc.)
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The Menu Bar
The Menu Bar across the top of the screen contains the drop-down menus File, Edit, Insert, Play, Options, Utilities
and Help.
These menus may be activated by clicking on the appropriate menu name or by pressing Alt and then the key
corresponding to the underlined character(s). As the mouse is not used for general editing, it will usually be quicker
to select Menu items by use of the Alt key sequence, when provided. For instance: Alt+F+S will save your music;
Alt+O+A will switch Abbreviated Play on and off; etc.
Many of the menu items, especially the ones on the Edit menu, also have single key shortcuts.
Any of the menu items that are 'greyed out' are unavailable on your version of the program, and clicking on them will
have no effect.

File Menu
When selecting filenames you should not change the 3-letter filetype at the end. The Editor automatically assigns the
correct filetype to each type of file used, and any confusion could cause files to be overwritten. The filename of the
music you are currently working on is always shown in the title bar at the top of the main window.
Clear Music
This deletes the current music from memory, and creates a blank roll of approximately 500 frames for you to start a
new piece of music. The High-Speed mode is also switched off, although you can reselect it if you need it.
Load New Organ Scale (ctrl+F11)
Before any music can be arranged on the Editor you must create a Scale Configuration file for the organ on which
you are working. This is created using the Scale Configuration Program. This menu option allows you to load this file
into the Editor. This should be done every time you are starting on a new piece of music from scratch. There is no
need to load in a new scale if you are going to continue work on a piece of music that you have already started, as
the scale will be contained within the music file. In fact, any scale already loaded into the Editor will be overwritten
by a music file.
You can change the organ scale at any time during work on a piece of music. This allows the same piece of music to
be used for different organs. The new scale, however, must have the same width as the original (ie: 16, 24, 32, 40,
48, 56 or 64 keys). Please note that if you attempt to load in a scale with a different width from the scale already in
memory, any music in the computer will be cleared after the new scale is loaded. (You are warned if this will
happen.). If you wish, you can change the width of the roll in the Editor using the Options menu.
You can identify the scale that is currently in use by using the Properties option on the File menu.
Load Music (ctrl+F12)
This option loads a complete music roll, and its associated Scale Configuration into memory. Any music and/or Scale
data that was already in memory will be overwritten.
Save Music
This saves your music and the associated Scale Configuration to a .mus file. It will be saved with the same name and
in the same place as the original file. The current filename and path is shown in the Title bar at the top of the window.
If you wish to save it under another name or in a different place, then use Save Music As.
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Save Music As
The Save Music As command saves your music and associated Scale Configuration to a .mus file. You are prompted
to select a file name. Use Save As rather than Save if you need to change the disk, directory (folder), or filename to
something different from their current values.
Save Part Music (Full Version only)
This option allows you to save just part of a music roll. You must have at least two markers set before using this
command. This saves the section of music between the two markers, including the two marked frames. If there are
more than two markers present, then the first two will be used. You will be prompted to enter a filename.
Part-music is saved as a .prt file, and is used to merge two pieces of music into a single file, using the Insert Part
Music option. Of course, you can position the markers at the beginning and end of the music, so the .prt file contains
the complete music!
Insert Part Music (Full Version only)
This option inserts a part-music file (.prt) at the current position of the cursor. Everything after this position will be
moved down to make way for the new music. Both pieces of music must be the same width, otherwise you will get
an error message. You can change the width of the current roll in memory using the Options menu. Please note that
whole music files (.mus) cannot be loaded in with this option. You must first create a .prt file of the music you want
to merge, or use the following option to merge two complete rolls together.
Append Complete Music Roll (Full Version only)
This option allows you to merge two (or more) complete music rolls together, by appending another roll onto the end
of the current one. This is a simplified method of appending one roll onto the end of another without having to create
a .prt file first. If you wish to append only part of a roll, or insert new music into the middle of a roll, you will still
need to use the Save Part Music and Insert Part Music options. You will be prompted to enter a filename, which
must be another .mus file of the same width as the music currently in memory.
Produce MIDI File
This is the main purpose of the entire program! It takes your music roll, converts it to a MIDI file, and saves it with a
.mid filetype. You can either accept the default filename (which will be the same as the music file) or enter a new
filename. All the notes in the music will be given MIDI numbers and channel numbers according to the information in
the Scale Configuration file. You can take this file and either play it directly on the organ if it is a MIDI organ, use it
to print out a music roll or book, or use it to control a MIDI operated punching machine. Any drum rolls in the music
will automatically be applied to the side drum key(s) on the organ; and any drums, etc. will be advanced by 1 frame.
You may be able to play this MIDI file back on your computer, depending on whether the MIDI numbers on the
organ are standard MIDI numbers. If not, you will just hear a garbled mess! Note that the music will start at the last
S command in the music roll. You may want to press ctrl+F3 before recording a MIDI file to make sure that it starts
from the beginning.
You can automatically include the Title of the music and the Arranger's name in the MIDI file by entering them on the
Music Properties page on the File menu (see below).
Produce Transposed MIDI File (Full Version only)
This is the same as the above option, except that the resulting MIDI file can be transposed up or down by a number
of semitones. This facility can be useful if you want to use the same music roll to produce MIDI files for organs which
use the same scale, but use different MIDI numbers. In this case, I prefer to make a different Config file for each
organ, which completely automates the process and prevents mistakes, but the Transposing facility does sometimes
come in useful as a 'quick fix'. It also allows MIDI note zero to be used (see the page on Possible Problems).
You will be asked how many semitones you want to transpose the music up or down by. Enter +ve numbers to
transpose the music up, or -ve numbers to transpose the music down.
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Produce Harmonist/Harmonette/Mini-20 File (Full Version only)
This is similar to producing a MIDI file, except that it produces Harmonist-2 and Harmonist-3 files for Pell
Harmonist, Harmonette, and MINI-20 organs. All the notes in the music will be given Harmonist numbers according
to the information in the Scale Configuration file, so make sure that you have a suitable Harmonist scale loaded (see
the Harmonist section). Note that the music will start at the last S command in the music roll, and any repeat sections
will be expanded out in the Harmonist file.
Produce 8-Channel MIDI File (Full Version only)
You can use this option to produce a MIDI file of the actual music as played by the Editor program when you press
the Play key. This will be a multi-channel file and should sound the same as the organ playing the music (as far as
your sound card will allow). You could send this file to the organ owner if he wants to hear what your music will
actually sound like on the organ. You can either accept the default filename (which will be the same as the music file
with a .mid extension) or enter a new filename.
Music Properties
This displays the properties of the current music roll and the organ scale. You may also enter the Title of the music,
the Arranger's name, and any other notes you require. Unless you enter any details these fields will remain blank. To
enter details, move the cursor over the blank field with the mouse, click, and type the message. Press Enter to finish.
Anything that you type will overwrite the existing information. The Title and Arranger information is embedded into
any MIDI file produced. To exit the properties screen, press any key.
Exit (alt+F4)
This command quits the Editor program and closes its window. You will first be prompted to save your music if you
have made any changes to it.

Edit Menu
All the commands in this menu are duplicates of the normal keyboard functions when editing a music roll. They are
provided for convenience, and in case you forget the key strokes; but it is far quicker to use the keyboard for all of
these functions.
Keyboard Editing Map (F1)
Prints a Help Screen listing all the editing keys and their function. Press any key to return to the editing screen.
Serial/Chord Editing Mode (S or C)
Puts the Editor in Serial or Chord mode (see Editing Modes). The Editor starts up in Serial mode. The current
mode is displayed in the Status Bar at the bottom right of the screen.
Delete Marked Section (F7)
This will delete the entire section of music between the two markers. This includes the marked lines themselves. If
there are more than two markers, the first two will be used. The music after the deleted section will be moved up to
fill the gap.
Move Marked Section to Cursor (F8)
This will move the section between the markers, including the marked lines, to the position of the cursor. The section
will appear immediately after the cursor frame. and all the music which was originally in that position will be moved up
to make way for it.
Copy Marked Section to Cursor (F9)
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This will copy the section between the markers, including the marked lines, to the position of the cursor. This is the
same as F8 except that the original passage is not deleted, thereby creating two copies of the passage in the roll. This
is the normal method of implementing repeats in the music. If there are more than two markers, the first two will be
used.
Delete all Notes on this Key (ctrl+F7)
This will delete all the notes on the currently-selected key in the music. To use it, move the red arrow to the key that
contains the notes that you want to delete, and either select this menu option or press ctrl+F7. Any non-musical
frames are ignored by this command, so any Remarks or Tempo commands will not be affected. An example of its
use would be to remove all the drum signals from an organ which is not fitted with drums.
Move all Notes on this Key (ctrl+F8)
This will move all the notes on the currently-selected key to another key. The new notes will be merged with any
existing notes on that key. If this is not what you want, then first delete the existing notes with ctrl+F7. To use this,
first move the red arrow to the key where you want to move the notes from. Select this menu option (or press
ctrl+F8). Then move the red arrow to the key which you want to transfer the notes to and press the menu option
again (or press ctrl+F8). If you change your mind half way through and want to abandon the move, just press the
Escape key. Non-musical frames are not affected.
Copy all Notes on this Key (ctrl+F9)
This will copy all the notes on the currently-selected key to another key. The new notes will be merged with any
existing notes on that key. If this is not what you want, then first delete the existing notes with ctrl+F7. To use this,
first move the red arrow to the key where you want to copy the notes from. Select this menu option (or press
ctrl+F9). Then move the red arrow to the key which you want to copy the notes to and press the menu option again
(or press ctrl+F9). If you change your mind half way through and want to abandon the move, just press the Escape
key. Non-musical frames are not affected.
Extend all Notes from Previous Frame (X)
Use this option to lengthen a single note or (more usefully) a complete chord in your music. Put the cursor on the
frame after the chord and then select this Menu option (or press X). The previous frame will be copied to this one,
and the cursor moved down another frame. Keep pressing X until the note or chord is as long as you want it. Any
notes already in the new frames will remain and not be deleted, so make sure that you don't extend any unwanted
notes.
Find Next Occurrence of this Note (F)
Use this option to find and jump straight to the next instance of this note. Place the red arrow at the note you want to
find and select this option (or just press F). The Editor takes you to the next occurrence of the note, or to the end of
the music if there are no more notes on that key. This option is extremely useful, and can semi-automate many tasks.
For instance, if you wanted to extend a register signal from 2 frames to 3 frames you could do this by continually
pressing the F key followed by the 3 key. If you wanted to convert a piece of music to an organ without (say) a G#
on it, you could instantly find every G# in the music roll and either remove it or transfer it to another note. Then if you
go to the beginning of the music and press F, it should jump straight to the end of the roll and you can be sure that all
the G#'s have been removed. Note that all REM lines are ignored during the search (otherwise the search would
stop at every reference line!).
Move Up to Previous Marker (ctrl+PgUp)
Use this option to find the previous Marker in the music. By setting markers at strategic points in the roll, you can
return immediately to these points without having to search for them.
Move Down to Next Marker (ctrl+PgDn)
Use this option to find the next Marker in the music. By setting markers at strategic points in the roll, you can return
immediately to these points without having to search for them.
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Remove All Markers (F3)
This option removes all Markers from the music roll. It is advisable to use this before setting up markers for the
Block Delete or Block Copy commands. Otherwise there may be some markers you are not aware of and you
might delete the wrong section!
Restore Start Line (ctrl+F3)
This option will remove all spurious S commands throughout the music roll, and reinstate a single S command at the
beginning of the roll (which may not necessarily be at the top). Use this before producing a MIDI file, to make sure
that the music will start at the beginning.

Insert Menu
Almost all the commands in this menu are duplicates of the normal keyboard functions when editing a music roll.
They are provided for convenience, and in case you forget the key strokes; but it is far quicker to use the keyboard
for these functions.
Insert Title and Copyright Information
This option opens up the Music Properties screen so that you can insert the title of the music, the Arranger, and any
other miscellaneous notes. You can also access this screen from the File menu. To enter these details, move the
cursor over the blank field with the mouse, click, and type the message. Press Enter to finish. Anything that you type
will overwrite the existing information. The Title and Arranger information is embedded into any MIDI file produced,
unless they are blank. To exit the Properties screen, press any key
Insert Frame (Enter)
This inserts a single blank frame at the cursor, and shifts everything down to make room for it.
Insert Blank Division (ctrl+Enter)
Inserts a whole blank division at the cursor position and shifts everything down to make room for it. The blank
division is equal to the length of one timing division.
Insert Reference Line (F2)
This will create a blank frame at the cursor and then place a single reference line of holes across that frame, useful for
minor divisions in the music.
Insert Reference Division (ctrl+F2)
This will create a major reference division. The top and bottom lines in the reference division will both be filled with a
line of holes, leaving the centre section blank for you to fill in your own comments.
Insert Octave Above (O)
This copies the note that the cursor is standing on, to an octave above (if available) and then moves the cursor to the
end of the note. If the cursor is not standing on a note, or if the octave note is not available, nothing happens. This
command was included to quickly expand a melody line of a piece of music, with the minimum of key presses.
Insert Trill - 1 Note Above (T)
This command inserts a trill at the cursor, for the duration of one timing division, and then moves to the end of the trill.
The trill is placed on the current note, and the next note above.
Insert Trill - 2 Notes Above
This command inserts a trill at the cursor, for the duration of one timing division, and then moves to the end of the trill.
The trill is placed on the current note, and the note two keys above. This type of trill would be used when you want
Created with the Freeware Edition of HelpNDoc: Easy CHM and documentation editor

to jump over an accidental (chromatic) note on the organ scale.
Insert Part Music At Cursor (Full Version only)
This is a duplicate of the Insert Part-Music option on the File Menu. It has been included twice, as it is relevant to
both menus.

Play Menu
These commands enable you to listen to your music. If you have configured the organ scale correctly it should sound
exactly the same as it will sound when played on the organ!
The Playing Mode can be changed by some of the options on the Options menu. The registers can be disabled, the
'pipework' can be selected, the percussion and Bass volumes can be changed, and Piccolos and Glockenspiel can be
transposed up or down.
Unfortunately, it is not possible to watch the music roll scrolling up the screen as the music plays. Nor is it possible to
change any of the settings whilst the music is playing (you might be able to change some of them, but they won't have
any effect!). This is because the music is played by passing it to the Windows operating system. Pressing the Escape
key terminates the playback routine and returns control to the Music Roll Editor. This also explains why there is
sometimes a short delay before the music starts to play, depending upon the complexity of the music. During this
delay, Windows is working out how to play the music! You can reduce this delay with the Abbreviated Play option.
Play from Reference Line (Tab)
This is the most commonly used Play function. Pressing the Tab key will play the current section of your music that
you are working on, from the beginning of the section. The tempo will be taken from the last Tempo line before the
section, and not the one at the start of the music, so it should be the correct tempo. Press the Escape key to stop
play.
Play from Cursor (Q)
This is similar to the previous function, but play is started from the cursor (actually 2 or 3 frames before it). The Q
key is next to the Tab key, so these two functions are side-by-side on the keyboard. Press the Escape key to stop
play.
Play from Start (shft+Tab)
This option plays the whole music from start to finish, even if the Abbreviated Play option is on. Press the Escape
key to stop play. The start of the music is taken from the last S command in the music roll, so you can place this
wherever you like. Press ctrl+F3 to restore the S command to the beginning of the music roll.
Play Harmonist File (Full Version only)
This option allows you to play Harmonist files (.har). Its main purpose is to test Harmonist files created by the
program, to check that they will play correctly. The whole music is played from start to finish. Press the Escape key
to stop play. There may be a delay before the music starts, depending on the size of the music.
You will need to load a suitable Harmonist scale in order to play the music. This is the same scale that was used to
produce the Harmonist file. Any Harmonist scale will do, as long as it contains all the notes that appear in the
Harmonist file This is because all Harmonist organs use the same note numbers. Do not use a MIDI scale as the
numbers are completely different!

Options Menu
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Some of these options are selected and de-selected using the same Menu item. When the option is selected, a tick
will appear next to the item in the Menu.
Change Screen Size
This option allows you to switch the music roll display between a large and a small screen size. The purpose of this is
to enable the program to run faster if you have a slow PC.
Play on Fixed Voice
This option disables all the registers when playing back the music, and plays the music using a fixed voice (which can
be chosen using the next Menu option). The reason for providing this facility is to make it much easier to test the
music as you are writing it. You will usually do this by pressing the Tab key, which starts the music playing at the
section you are currently working on. But there may not be any register slots at the start of the section, so the
registers will not be set, and you will probably hear no melody notes at all! Setting the music to play on a fixed voice
prevents this from happening. You will usually write the music with fixed voice enabled, and when nearly finished add
the register slots and disable the fixed voice, so that the proper registers can be heard.
Select Fixed Voice
This option works in conjunction with the one above to enable you to select the fixed voice used when the registers
are disabled. The options are Flutes, Bourdons, Violins, and Trumpets. When the registers are enabled, this option
will have no effect.
Abbreviated Play
When this option is selected, the Play commands will play the music for a short duration and then stop. This option
has been provided to remove the delay before the music starts. When testing your music, you are usually only
interested in the section you are currently working on. By passing only a short section of the music to Windows to
play it, the starting delay is eliminated, and the music should start straight away. This option affects all the Play
commands except for the Play From Start command (shft+Tab). The duration of play is about 30 seconds,
depending on the Tempo setting. Of course, the playing can still be terminated at any time by pressing the Escape
key.
High-Speed Mode
This option switches the High-Speed mode on or off. This mode has been included to provide compatibility when
importing MIDI files into the Editor. It is not used in normal circumstances. When in High-Speed mode, a 3 is
added to the number of dots on the Tempo line, rather than a 15. So the highest speed becomes 300/3 = 100th
second, rather than 300/15 = 20th second. The High-Speed mode can generate music that is unplayable on
organs, so a warning is given whenever this mode is selected. You may be able to convert high-speed music to
normal speed by halving the frame resolution (see below) but any notes which are only a single frame may be lost
See the section on Importing MIDI files.
Move Editing Line Up (F5)
This option moves the editing line up the screen so that more of the music ahead of the editing position can be seen.
It also moves it closer to the scale across the top of the screen, which may make it easier to identify the notes.
Move Editing Line Down (ctrl+F5)
This option moves the editing line down the screen so that more of the music before the editing position can be seen.
Increment Timing Divisions (F4)
Decrement Timing Divisions (ctrl+F4)
These two options allow you to change the frequency of the timing divisions across the screen (ie move them further
apart or closer together). You can set these to whatever you like, according to the rhythm of the music. It is just a
visual alignment aid, and has no effect on the music.
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Decrease the Width of the Roll
Increase the Width of the Roll
These two options allow you to change the width of the music roll. You may need to do this if you want to convert
your music to play on an organ with a different number of keys. As explained in the Scale Configuration program, all
scales are multiples of 8 keys wide. These two options work by removing 8 keys or adding 8 keys to the right-hand
side of the music roll. You will usually (but not always) want to load in a new scale after changing the width of the
roll, so you are asked whether you want to do this or not. You will also be given a warning if you are reducing the
width of the roll and there are any notes in the top 8 keys which will be deleted. Of course, you could write 20-note
music on a roll that is 64 keys wide, and just leave the top 44 keys spare. The purpose of reducing the width of the
on-screen roll as much as possible is to enable the program to run as fast as possible, and it makes it easier to edit the
music, as you can jump straight to the right-hand notes with the ctrl+Right keys.
Double the Frame Resolution
Halve the Frame Resolution (Full Version only)
These two options allow you to change the frame resolution of the music. This means that the frames-per-second
rate of the entire music is either doubled or halved, and all the note lengths are readjusted to suit. Doubling the frame
rate means that all the notes will be twice as long as before. Halving the frame rate means that all the notes will be
half as long as before. The purpose of this is to allow you to change the resolution if you find that you have chosen a
rate that is too slow or too fast for the music you are writing. If, for instance, you find that you need to get two notes
in the space of one frame, you would double the resolution so that the same unit of time now occupies two frames
instead of one. If you are writing a slow piece of music, you may find that even the shortest note occupies more than
one frame. You could compress the whole tune by halving the resolution, which would halve the length of all the
notes on the screen. This facility is also useful when importing MIDI files into the Editor and you have chosen an
import resolution which turns out to be much higher than necessary for the music. You can gradually halve the
resolution until the shortest note occupies a single frame. Be aware that, unless the tempo is very slow, doubling the
resolution of a piece of music will often put the Editor into High-Speed mode. This is because the fastest frame rate
in the Normal-Speed mode is 20 frames/second; and any tempo above 10 frames/second will become higher than 20
frames/second if the resolution is doubled.
Percussion Volumes
This option enables you to adjust the volume of the Side Drums, Bass Drum & Cymbal, and Wood Blocks for
playing the music on your computer. Each can be set to Loud, Medium or Soft.
Drum Roll Speed
This option allows you to adjust the rate of the Side Drum Roll. The options are Slow (6 beats/sec), Medium (7
beats/sec), and Fast (8 beats/sec). The default is Medium. The numbers refer to the total beats as heard, so each of
the two drumsticks will operate at half the bps figure. Note that this setting also affects the drum rolls that are
embedded into the music when the Editor produces a MIDI file. So if you are writing music for an organ with a slow
response, set the drum rolls to Slow.
Transpose Up
This option allows you to set the pitch of the Piccolos and the Glockenspiel with respect to the other registers. You
can set them to the same pitch as the rest of the organ, or transpose them up 1 octave or 2 octaves. The default is
standard pitch. This setting depends on your personal preference, and also what your sound card and speakers
sound like. Piccolos usually benefit from being transposed up at least 1 octave. This setting only affects the music as
played back on your computer, and doesn't change the pipework on the organ!
Bass Helpers
This option enables you to adjust the volume of the Bass Helpers for playing the music on your computer. They can
be set to Loud, Medium or Soft. The Bass Helpers are octave pipes connected to the Bass pipes, and their setting
will depend on the bass response of your speakers.
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Utilities Menu
Check Music for possible Errors (Full Version only)
These three options allow you to quickly check your music for possible errors. The errors are:
Two Bass notes sounding together
Bass note too short
Register pulse too short
Please note that these are not necessarily errors, as it all depends upon the way you want to write your music, and
only you can decide whether these are errors or not. But generally speaking it is not good practice to have two or
more Bass notes sounding together, unless you want a particularly heavy Bass. Likewise, Bass notes that are too
short may not even sound at all because large Bass pipes need time to build up volume. Generally speaking, all Bass
notes should be at least two frames long. Register pulses should be more than one frame long, unless the organ
registers are electronically controlled, as in the Harmonist system. Electrical relays generally need 2 frames, and
pneumatic relay boxes often have very long pulses in the music, sometimes up to 5 or 6 frames.
Selecting one of these options will check the music from the current position of the cursor. If an error is found, the
program will beep and the error will appear on the editing line. You can either deal with the error or leave it if it is
deliberate. Select the option again to check the rest of the music, until you come to the end. You can speed this
process by using the Alt key to directly select the checks on the Menu bar. (Alt+U+2, Alt+U+B and Alt+U+R).
See the Menu Bar.
Configure Organ Scale
This command starts up the Scale Configuration program (Config.exe) to enable you to inspect and/or make changes
to a Scale Configuration file without leaving the Music Roll Editor. If the Config.exe file cannot be found in the same
folder as the Music Roll Editor, the command will be aborted. When you have finished using the Config program,
close it down in the normal way and you will be returned to the Music Roll Editor.
Convert the Music to a Different Scale (Full Version only)
This command allows you to convert music from one organ scale to another, by moving all the notes into different
positions on the music roll. Using this facility, music rolls arranged for one scale can be physically converted to
another scale, which may be completely different. This allows the main conversion work to be done automatically,
then any notes which are not common to both scales can be edited in or out manually. It also allows you to change
your scale layouts around as you wish, as all your existing music roll files can be modified to fit any new scale
changes.
This feature works by using special Conversion Scales which are the same as ordinary organ scales, except that they
contain information for how to convert the music to a different scale, rather than information about the organ key
layout. These scales are made up in the same way as ordinary scales, by using the Scale Configuration program; but
instead of entering the organ key numbers in the Key table, you enter the new position of the note on the music roll.
The Music Roll Editor uses the numbers in the Key table to move all the notes into different positions across the roll.
The Conversion Scale is usually made up by taking the standard scale for that organ and changing the organ key
numbers, and then saving it under a different filename. Because Conversion Scales are only used for converting
music from one scale to another, most of the other information in the .cfg file is not used.
So, to convert your music from one organ to another, load your music into the Editor as normal. Then load in the
required Conversion Scale. On the Utilities menu select Convert the Music to a Different Scale. The Editor will
convert the music to the new organ scale, and then ask you whether you want to load the scale corresponding to the
new music. You would normally answer 'Yes' to this, as after all the notes in the roll have been rearranged to fit a
different organ, you will need to load in the scale for that organ. The main reason for not loading the new scale in
straight away is that it might be a different width from the old one. In which case you would need to change the width
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of the roll before you can load in the new scale.
It should be understood that if you are converting your music into a narrower scale, you would need to move the
notes into their new positions first, then reduce the width of the roll, then load in the new scale. If you try to reduce
the width of the roll before the notes have been moved, many notes are obviously going to be deleted! Similarly, if
you are converting your music into a wider scale, you would need to increase the width of the roll first before moving
the notes into their new positions. Otherwise there will be nowhere to move them to!
After loading in the new scale, you should be able to play the converted music, and the notes should all be in their
right positions. You will obviously need to add any missing notes that were not on the old scale, and do quite a bit of
artistic tidying up, as necessary.
During the conversion process, Tempo frames, Remark frames, and other non-musical frames are left untouched so
that these commands will still operate properly in the new roll.
Convert Sectioned Music to Continuous (Full Version only)
This option has been provided for existing users who wish to convert their old sectioned music files to continuous
files. Music with a lot of repeat sections can be quite difficult to sort out, and as there is no longer any particular
advantage in using repeat sections, it can be useful to convert them into a continuous form going from the top of the
roll to the bottom. The conversion works by going through the music in the same order as it would be played, and
creating a new .mus file instead of a MIDI file. The new music file is then loaded into the Editor over the top of the
original file. Obviously, the new file will be longer than the original, as all the repeated sections will appear more than
once. In the process, all the J-lines and D-lines will be removed from the music, as they are no longer applicable.
Import MIDI File into Editor
As already mentioned, the Music Roll Editor is not intended as a general-purpose MIDI editor, but this command has
been included to enable existing MIDI files to be loaded into the Editor. For more information on this facility, see the
separate section in the manual. Any imported MIDI file will overwrite the current music roll in the Editor, so you
must save it first.
Import Harmonist File into Editor (Full Version only)
This option allows you to import Harmonist-2 and Harmonist-3 files into the Music Roll Editor. It also displays
information about the chip. For more information on this facility, see the separate section in the manual. Any
imported file will overwrite the current music roll in the Editor, so you must save it first.

Help Menu
Help Screen
This command calls up the main Help Screen, listing all the keyboard functions. This can also be accessed by
pressing F1. Press any key to return.
Instruction Manual
This command calls up this Instruction Manual, along with search facilities to make it easier to find the information you
are looking for.
About
The About command displays the version number of the Music Roll Editor, and the copyright information, etc.

Created with the Freeware Edition of HelpNDoc: Easy CHM and documentation editor

Scale Configuration Program
The Scale Configuration program (Config.exe) allows you to set up the Music Roll Editor to work with any organ
scale and key frame layout that you wish, up to the maximum of 64 keys. This is equivalent to the paper scales used
with a composer's plank, but in addition, many more options may be specified.
One of the main functions of the Music Roll Editor is to be able to simulate the sound of the organ that the music is
being written for. This means that it has to read your music and play it in the same way as the real organ would play
it, including register changes, etc. All the information needed to do this, including details of the organ's pipework,
registers, and percussion, is contained in the Configuration file that is produced by the Scale Configuration Program.
When you have entered the details into the Config program it will produce a Configuration file (.cfg) which is saved
on disk. This file can then be used for all pieces of music written for that particular organ. If you are producing music
for different scales of organ, a separate folder should be kept containing all the Configuration files for the various
instruments. In this way, the editor can be immediately set up to work with all the scales normally encountered,
without having to go through the configuration procedure each time. As well as setting up a new scale configuration,
the program also allows Configuration files to be modified, inspected and copied.
To start the Scale Configuration program, you can either double-click on it, or you can run it from inside the Music
Roll Editor by clicking on the Utilities menu. You will see that the program is self-explanatory in use, and prompts
you at every stage to enter the information required. If you make a mistake at any time, don't worry about it. Simply
carry on and save the data as normal, you will be able to return to make corrections later. The program will not
accept data that is obviously wrong, if a question is repeated this indicates that the answer you have given is not
acceptable.
The first option in the program allows you to create a brand new Configuration file from scratch, or to load in and
modify an existing Configuration. Suppose you have already arranged music for the standard 48-key scale and now
wish to produce music for a similar organ with a glockenspiel. You would load in your standard 48-key scale and
modify the registers, rather than create the whole scale again from scratch.
The section on book and roll measurements was originally used by the program to print out music rolls and books,
but as this feature has now been dropped from the program, this information is really just for your own reference
purposes.
When setting out the organ scale, remember that you can use any symbol that you like to represent the function of
each key on the organ (provided that you remember what you've used!) and you can also set them out in any order
across the roll. This allows keys to be grouped separately into sections (Melody, Accompaniment, Bass, Percussion,
Registers, etc.) and scrambled scales to be arranged logically across the screen.
One point to note is that there is only enough space on the screen to allow a single character to represent each key on
the scale. This means that, for example, F# cannot be used as it would occupy the space for two keys. However, if
the sharp follows immediately after the natural note (as is almost always the case) a single # symbol is all that is
required to identify the note. If this is not the case then various symbols are provided as an alternative, or you could
use capital letters for the natural notes and lower case letters for the sharps.
A number of sample Configuration files are provided with the Editor. These can be used as examples, or starting
points for making up your own scales. Ready-Made Scales Supplied.

Organ Key Layout
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When defining an organ scale, you can arrange the keys and notes in any order across the top of the screen. Each
Scale Configuration file contains two main conversion tables: A Key table and a MIDI table. The Key table
converts the key positions on the screen to their true position on the organ; and the MIDI table holds the MIDI
information to enable each note to be played on your computer sound card. When entering information into the Key
table you will need to know how the keys on the organ are laid out, and when entering information into the MIDI
table, you will need to know the standard MIDI number for each note on the organ (see the section on MIDI).
Computer sound cards always use standard MIDI numbers.
If you are writing music for a MIDI organ or a Harmonist organ, the Key table will contain the MIDI number or the
Harmonist number of the note on the organ, rather than the key number, as the organ will not have any keys! These
numbers are equivalent to the key numbers on a conventional organ. Harmonist numbers are always standardised,
but MIDI numbers may or may not be standard MIDI numbers (often they are not). It all depends on how the organ
has been wired up. MIDI note numbers go from 0 to 127, so there is provision for MIDI organs to have 128 'keys',
but there is no standard way of connecting these MIDI numbers up. On organs with no percussion or register keys,
the notes are usually connected up to their standard MIDI numbers (see the section on MIDI). But there is no
standard MIDI numbers for the non-musical keys such as registers or percussion, so these are usually connected to
spare MIDI numbers. Sometimes the standard MIDI numbering is ignored altogether and note 1 on the organ is
wired up to MIDI No.1, note 2 to MIDI No.2, note 3 to MIDI No.3, etc. So before you can define the organ
scale, in the case of MIDI organs you will need to know the MIDI number of each key on the scale.
When it comes to the MIDI table for the computer sound card, this will always use standard MIDI numbers. MIDI
note numbers go from 0 to 127, but as far as organ music is concerned, only notes in the range 35 to 95 are generally
used (middle C is number 60). All the musical keys will be given their standard MIDI numbers. Non-musical keys
are given numbers above 127, to distinguish them from normal musical keys.
So in the MIDI table, numbers from 1 to 127 are used for musical notes; numbers from 128 to 150 are used for
various percussion instruments; and numbers from 201 to 255 are used for register keys.
The following pages explain the function of the various Percussion and Register numbers above 127.

Percussion
Here are the Percussion numbers to be entered into the MIDI table, to achieve the various percussion effects:
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Perc. No.
128
129
130
131
132
133
134
135
136
137
138
139
140
141
142
143
144
145

Function
Bass Drum
Cymbal
Bass Drum and Cymbal
spare
Bass Drum and Cymbal, plus Forte Register
Bass Drum and Cymbal, plus Violins On / Bourdons Off
spare
Side Drum single-stroke (obsolete - use 136)*
Side Drum (Single-Stroke & Roll)
Wood Block
spare
Bell
Tambourine
spare
Side Drum single-stroke, or Wood Block if Bourdons are selected (obsolete - use 143)*
Side Drum, or Wood Blocks if Bourdons are selected
Bass Drum. Add Cymbal if Violins are selected
Bass Drum. Add Cymbal if Glockenspiel is selected

For example, when entering numbers into the MIDI (Sound Card) table, you would direct your Bass Drum key to
number 128. If it is a Bass Drum and Cymbal, you would direct it to number 130, etc. Number 132 is used for
31-keyless organs where the Bass Drum also operates the Forte register. Number 133 is similar, but switches the
Bourdons over to Violins, as on some Trueman organs.
Curiously, there is no MIDI sound for a drum roll. In theory, it is only necessary to insert a trill on the side drum keys
on the Editor screen, and they will be transferred to the correct keys on the organ in the same way as all the other
notes. Unfortunately the tempo of the music may not be ideal for producing a good drum roll speed. I have spoken
to a few people who have tried to write organ music on a standard MIDI editor, and they all said that the hardest
thing to do was drum rolls. The difficulty arises in knowing how long to make the notes, as the screen does not
directly relate to millimetres or milliseconds, but relates to crochets and quavers, etc. I have therefore provided a
routine to generate side drum rolls automatically, and transfer the alternating pattern out to the appropriate keys on
the organ. The drum roll speed is unaffected by the tempo of the music, and the facility works with single and 2-key
side drums. Side drum rolls are entered in the music roll as a continuous slot for the duration of the drum roll.
Single-key side drum systems, are quite straightforward, but a 2-key system is a little more complicated because
drum rolls require an alternating pattern on the two keys, whilst single-strokes require an equal pattern on both keys.
This used to be accomplished by designating one key on the Editor screen as a drum roll key, and another key as a
single-stroke key. The drum roll key was taken to number 136 and the single-stroke key was taken to number 135
in the MIDI table. However, the latest version of the program automatically distinguishes between a single-stroke
and a drum roll by checking the length of the side drum slot in the music. If it is only one hole long, then a single
stroke will be generated on both side drum keys; and if it is longer then the program produces an alternating hole
pattern on both side drum keys.
* The single-stroke Nos.135 and 142 have been kept for backwards compatibility with existing music. Their
functions are now identical to Nos.136 and 143, which should be used for new music. Drum rolls and single-strokes
are now detected automatically and do not need different keys (see above paragraph). You do not need to modify
your existing music, it will play exactly the same as before. See notes on existing music.
Number 143 is used instead of number 136 if your side drums are switched over to wood blocks by the Bourdon
register.
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Numbers 144 and 145 are used instead of numbers 130, if the Cymbal is coupled to the Bass Drum by a register.

Registers
Organs vary widely in their pipework and method of register selection. To enable the program to simulate the sound
of any organ just by reading the notes in the music roll, it has been necessary to devise quite a comprehensive system
to cope with all the different variations. There are 32 register functions, numbering from 201 to 232. The functions
of each of these is contained in a Register Definition file (.rdf) which is part of the .cfg file for each organ scale. All of
the 32 register numbers are predefined with common register functions, but you are able to define your own register
functions and put them on any register number. In this way, you can make up your own Register Definition files to
suit your own needs. In practice, it should rarely be necessary to define your own register functions, but the facility
has been provided for those who wish to do so.
Each organ scale can be split up into four sections: Bass, Accompaniment, Counter-Melody, and Melody (on
German organs the Counter-Melody is sometimes called the Trumpet section). Each of these sections can have
independent register selections. A total of six registers are possible in each of the sections. These six are initially set
up as Flutes, Bourdons, Violins, Glockenspiel, Piccolos, and Trumpets; (although these can be changed to anything
else if desired). You can have any combination of these six registers in each of the four sections of the organ. When
defining each register function, you tell the program which registers are cancelled by the key, and which registers are
set by the key. You need to do this for all of the four sections, as they are all independent of each other. So there
are a total of eight instructions necessary for each register function (4 'Cancels' and 4 'Sets').

Fixed Registers and Pipework
Not all pipework will be selected by register keys. Some of the ranks will be permanently selected, and in play all of
the time, particularly in the Bass and Accompaniment. These are referred to as 'Fixed Registers'. These registers are
completely unaffected by the register keys, and any registers that are selected by the keys are added to the fixed
registers. They do not replace them. Likewise, it is not possible to cancel any of the fixed registers. If you want to
cancel a fixed register, then you must allocate it to a register key instead of defining it as a fixed register!
Fixed registers and register key functions are defined and set up using the Scale Configuration program. Just follow
the instructions in the program.

Register Priorities
On most organs, it is necessary for some register keys to take priority over others, when they are both operated
together. This is the way in which the 'Declanche' system works. This has been achieved in the program by making
some of the register keys High Priority and some keys Low Priority. If two register keys are operated together, the
High Priority key will override the Low Priority one. Register numbers 201 to 228 are High Priority, and the last four
numbers 229 to 232 are Low Priority.
In addition, register numbers 227 and 228 are Continuous Hole-type registers. These are commonly found on
German organs, where the registers are operated by a continuous series of holes. Here, the Set and Cancel
instructions will be reversed when the register key is switched off at the end of the holes.
Register numbers 229 and 230 also have a special function in addition to their normal function. They can also be
operated by the bass drum. Register number 229 is coupled to Percussion number 132, and Register number 230 is
coupled to Percussion number 133. (See the Percussion section for more details.) This is a common arrangement
on 31-keyless fair organs, where the bass drum can also operate a register.
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Register Functions and Types
Here are the standard definitions of the 32 Register functions, as supplied:
RegisterName
Registers Cancelled
No.
High Priority (Overrides other keys if operated together)
201
General Cancel
All
202
Melody Cancel
All Melody
203
Trombones
None
204
Counter-Melody Violins
None
205
Counter-Melody Trumpets
None
206
Flutes
None
207
Bourdons
None
208
Violins
None
209
Glockenspiel
None
210
Piccolos
None
211
Trumpets
None
212
Violins & Glockenspiel
None
213
Cellos & Violins
None
214
Trumpets & Trombones
None
215

German Crash Forte

216
217
218
219
220
221
222
223
224
225
226

Counter-Melody Trumpets
Counter-Melody Flutes
Flutes
Bourdons
Violins
Glockenspiel
Piccolos
Flutes On / Trombones Off
Trombones On / Flutes Off
Violins On / Bourdons Off
Bourdons On / Violins Off

None
None
Bass Trombones
Counter-Melody Violins
Counter-Melody Trumpets
Melody Flutes
Melody Bourdons
Melody Violins
Melody Glockenspiel
Melody Piccolos
Melody Trumpets
Melody Violins+Glockenspiel
Accomp.Cellos, Melody Violins
Bass Trombones, Acc.Trumpets
Melody Trumpets
None
Acc.Cellos+Trumpets
Melody Violins+Trumpets+Piccolos
All
Counter-Melody Trumpets
All
Counter-Melody Flutes
All
Melody Flutes
All
Melody Bourdons
All
Melody Violins
All
Melody Glockenspiel
All
Melody Piccolos
Bass Trombones
Bass Flutes
Bass Flutes
Bass Trombones
Melody Bourdons
Melody Violins, Glockenspiel
Melody Violins+Glock Melody Bourdons

Continuous-Hole Type (Release of key cancels the register)
227
German Crash Forte
None
228

Trumpets Off

Acc.Trumpets
Melody Trumpets

Low Priority (Overridden by other keys if operated together)
229*
Violins & Glockenspiel
None
230*
Violins On / Bourdons Off
Melody Bourdons
231
Declanche
All
232
Melody Declanche
All Melody
Tremulant Function
No.
Name

Registers Set

Bass Trombones, Acc. Trumpets
Melody Violins+Trumpets+Piccolos
None

Melody Violins+Glockenspiel
Melody Violins
None
None

Cancelled by
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251

Bourdon Tremulant

231 or 232 Declanche

*Numbers 229 and 230 can also be coupled to the Bass Drum and Cymbal, via percussion numbers 132 and
133.

Practical Examples
If you study the standard register definitions above, you will see that they are arranged in some sort of order.
Numbers 201 and 202 only have Cancel functions and do not set any registers. The same for numbers 231 and 232.
These numbers are the High Priority and Low Priority Register Cancel functions.
Numbers 203 to 215 only have Setting functions, and these are the main numbers used to set the registers in most
organs.
Numbers 216 to 222 have both Setting and Cancelling functions. They cancel all existing registers before setting their
particular register. These types of registers are used on Harmonist organs.
Numbers 223 to 226 have been given change-over functions. They operate one register and cancel another one.
Numbers 227 to 230 have special functions, which have already been discussed.
An organ using the common Declanche control system would use numbers 203 to 214 to set the various registers,
and number 231 to cancel them. Number 231 is Low Priority, so is overridden by all the setting keys.
Harmonist organs do not use Cancel keys, so would use numbers 216 to 222.
Organs with bass drum register control would use either percussion number 132 or 133 to operate the bass drum.
These also operate registers 229 and 230, (which can be re-defined to do what you want). The registers would be
cancelled with key 201 or 202. Note that in this case the register functions are Low Priority and the Cancels are
High Priority, so the bass drum registers are always overridden by the Cancel key.
Organs with simple Piano and Forte keys can use numbers 203 to 214 to bring in the Forte register(s), and any of the
Cancel functions as the Piano. In this case it doesn't matter which has priority, as the keys are never operated
together (although you could arrange for the effect to be identical to the one on the organ if they are operated
together). The Piano pipework would be specified as a Fixed Register, as it is always in play. Only the Forte
pipework is switched on and off.
Organs with changeover registers where one rank of pipes replaces another one (most notably Violins/Bourdons) can
use virtually any of the register numbers to perform those functions, as long as the number has been defined with the
required functions. Numbers 223 to 226 have already been defined with four of the common ones. In this case there
are no Fixed Registers, as none of the pipework is permanently in play.

Types Of Register
For those not familiar with the different register cancelling mechanisms, they function as follows:
Declanche Type: This is the most common mechanism. It uses a separate key to set each register, and a single key
(the Declanche key) to cancel all registers. The setting function of each register key overrides the cancelling action of
the Declanche key when both are operated together, so registers can still be cancelled individually. The 'setting'
pulses should be longer than the Declanche pulse.
Harmonist Type: This mechanism does away with the Declanche key by effectively cancelling all previous registers
when a new combination is selected. The cancelling feature is automatic, you just select the registers you want and
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unselected registers are automatically cancelled. Register pulses should all be the same length.
Set/Cancel Type: This type uses two keys to control each register, one key sets the register, and the other one
cancels it. Because two keys are required for every register on the organ, it is only used on organs with one or two
registers. Do not operate both keys simultaneously, otherwise you will get unpredictable results.
Changeover Type: This is a method of controlling two registers by the same key. Some organ scales have
registers which switch one rank of pipes off, and another rank of pipes on. For instance, it is a common arrangement
to switch the Melody over from Violins to Bourdons with a single register key. Another key will usually be used to
switch the registers back again. Do not operate both keys simultaneously!
Continuous-Hole Type: This method is very common on German organs, and uses only one key per register.
Each register key is operated for as long as necessary by a long continuous slot in the music. Because such music is
punched with a series of round holes as opposed to slots, the music is not seriously weakened.
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Producing MIDI Files
All MIDI files created by the Music Roll Editor are single track, type 0 files. Either 8 channels for playing on MIDI
sound cards, or single channel for playing on organs. The Title and Arranger information from the Properties screen
is embedded into any MIDI file produced. The Title is placed in the MIDI Track Name, the Arranger is placed in
the Copyright field, and a message containing both is placed in the Free Text field at the beginning of the MIDI file.
These titles will also work in the German Thuringer instruments (unlike most MIDI files). If no information is entered
onto the Properties screen, then no text is written to the MIDI file.

Producing Standard MIDI Files For Electronic Instruments
In the case of electronic MIDI organs, all that is necessary to produce music for these is to use the 'Produce
8-Channel MIDI File' option on the File Menu. This will produce a MIDI file of the music roll, as you can hear it
played on your computer when you press SHFT+TAB. All the options on the Options menu will be active, so you
can vary the drum volume and pipework, etc. You can take this MIDI file and play it on any other MIDI instrument,
and it should sound roughly the same (allowing for differences in the instrument voices). This is a good way of
sending demo music to organ owners so that they can hear what the music should sound like on the organ.

Producing MIDI Files For Mechanical Organs
It is possible to install a MIDI system in a pipe organ in such a way that it is completely MIDI compatible. This
would involve switching the pipes on and off with the correct Note On and Note Off commands, connecting the
drums to the appropriate notes on channel 10, and using the various Program Change messages to select the
registers, etc.
However, most organ installations are not MIDI compatible, and only use the MIDI system in a very primitive and
non-standard way. Most systems work by using off-the-shelf MIDI hardware purely as a means of recording the
pattern of holes in a music book or roll, and storing them on a computer disk. When the disk is played back it
operates the original keys on the organ, as if the book was playing. The percussion and register signals are treated in
the same way as ordinary notes, and switched on and off by Note On and Note Off commands just as they appear in
the music. As the tone is not generated electronically, the MIDI voices are not used, and even channels have no
meaning. All the MIDI data consists of is a sequence of Note On and Note Off commands that duplicate the holes in
a music book or roll. Having said this, this method is perfectly adequate for playing a mechanical organ, and the
hardware required is much simpler than that required to give a true MIDI simulation, which would be superfluous
anyway.
On the face of it, it would seem to be much simpler to produce music for this type of organ, than for a General MIDI
organ, because only a single channel is used, and much less MIDI data is required. However, the difficulty arises
from the fact that the organs do not conform to the MIDI standard, and can be wired up in almost any way. For
instance, in a 48-key organ, the keys could be connected up to their correct MIDI pitch numbers, or they could be
wired up to MIDI note numbers 1 to 48, or they could be wired up completely randomly. In practice, all these
methods have been used. Register and percussion keys are sometimes connected up to unused notes in the middle of
the scale (G#, D#, etc.). In addition, the music has to be on the correct channel. So if you are going to produce
music for one of these types of organ, it is essential that you find out the details of the organ scale, and the MIDI note
and channel numbers.
To produce this type of music, you use the 'Produce MIDI File' option on the File menu. All the data from the music
roll is recorded exactly as it appears on the screen (just like printing out a music book). The Organ Key Table is
used to direct any note on the screen to any MIDI note number on the organ. The channel information is also taken
from the Scale Configuration file. Drum rolls and drum key advances are produced automatically. The Properties
box on the File menu will tell you if Drum Advance is active or not. Using your existing music.
All notes are recorded with a velocity of 64, which is half of the maximum velocity. This is in accordance with the
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MIDI standard for fixed-volume instruments.
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Producing Harmonist Files
The Editor will produce music files for Harmonist-2 and Harmonist-3 organs, including the popular Pell Harmonette
and Mini-20 organs. This music is stored in Eprom chips and you will need an Eprom programmer to store the files
on the chips.
Generally speaking, Harmonist-2 music takes up less memory than Harmonist-3 music, but Harmonist-3 chips are
twice as big, so are more suitable for very long music (H2=16KB, H3=32KB). All Harmonist-3 organs will also
play Harmonist-2 music, so Harmonist-2 files should be used whenever possible, to maximise the number of tunes on
a cartridge. Both types of music allow for Extension files which will play automatically after the main file has finished.
Harmonist-2 rack-type organs play music on 32KB chips, which are configured as two 16KB tunes.
Cartridge-type organs play music on 4Mb chips (512KB) which are configured as sixteen 32KB tunes, thirty-two
16KB tunes, or sixty-four 8KB tunes.
To produce Harmonist music, choose the option on the File menu. You will be prompted to enter Title and other
messages to go into the chip. These are not taken from the Properties screen. The Editor will direct each note on the
scale to its Harmonist number in the Configuration file, so make sure that you have a Harmonist Scale loaded in, and
not a MIDI one, as the numbering scheme is completely different. Harmonist note numbers go from 1 to 63 (see
below). If your music contains repeat sections it will be compiled in its expanded form.
Any drum advance will be automatically applied when compiling the file, but drum rolls are treated differently from
normal organs, as an automatic drum roll is built in to the organ system.
Harmonist-2 music has a maximum of 16 notes that can be switched on at the same time. This is usually more than
adequate for most music. If you get a 'Too Many Notes' error during the compilation process, the Editor should
return you to the frame where the error occurred so that you can correct it. There is no such limitation with
Harmonist-3 music.
Unlike MIDI, the Harmonist system has a standard numbering scheme, so the difficulties mentioned in the MIDI
section do not arise.
The Numbering scheme is as follows:
Note
No.
1
2
3
4
5
6
7
8
9
10
11
12

Note

Section

F
G
A
A#
B
C
D
E
f
g
a
a#

Bass
Bass
Bass
Bass
Bass
Bass
Bass
Bass
Accomp.
Accomp.
Accomp.
Accomp.
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13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37
38
39
40
41
42
43
44
45
46
47
48
49
50
51
52
53
54
55
56
57

b
c
c#
d
d#
e
f
f#
g
g#
a
a#
b
c
c#
d
d#
e
f
f#
g
g#
a
a#
b
c
c#
d
e
f
Bass Drum
Glockenspiel
Violin
Side Drum
Bourdon
Flute/Piccolo
CM Register
b
c
c#
d
d#
e
f
f#

Accomp.
Accomp.
Accomp. (Tremulant - note 15 and 17 together)
Accomp.
Accomp. (Tremulant - note 15 and 17 together)
Accomp.
Accomp.
Accomp.
Melody
Melody
Melody
Melody
Melody
Melody
Melody
Melody
Melody
Melody
Melody
Melody
Melody
Melody
Melody
Melody
Melody
Melody
Melody
Melody
Melody
Melody
Percussion
Register
Register
Percussion (automatic drum roll)
Register
Register
Register
Counter-Melody
Counter-Melody
Counter-Melody
Counter-Melody
Counter-Melody
Counter-Melody
Counter-Melody
Counter-Melody
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58
59
60
61
62
63

g
g#
a
a#
b
c

Counter-Melody
Counter-Melody
Counter-Melody
Counter-Melody
Counter-Melody
Counter-Melody

Smaller organs have fewer notes, but still use the same numbering scheme
Registers are selected by a short pulse on the register key, which will also cancel any registers not selected at the
same time.
A continuous note on the Side Drum key produces a drum roll
Notes 15 and 17 together switch on the Tremulant, which is cancelled like any other register.
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Music Roll and Book Printouts
The original version of this program could print out a music roll directly on a dot-matrix printer, but this was thought
to be unnecessary now that most music is punched out on automatic machines, and free software is also available
which will do a roll printout from a MIDI file.
Here are some examples of programs which will print out music rolls and books from a MIDI file:

Midiboek

http://huizen.daxis.nl/~Ppaardekam/midib1e.htm

Mid2Car

http://membres.multimania.fr/mid2car/US_mid2car.html

Alternatively, I can punch out your music rolls automatically for the common street organ scales. For details see my
web site:
Roll Punching

http://www.melright.com/busker/punching.htm
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Advanced Features
This section contains information about some of the more advanced features of the Music Roll Editor.
You probably won't need to use any of these!

Repeat Sections
Important: This feature is provided for backwards compatibility with previous versions of the program. It
is not recommended for new music.
Almost all music contains some sections which are repeated. The Editor contains a facility to enable you to define
any part of the music as a repeat section, and then to play that whole section at any point or number of points
throughout the music, without having to enter the music data into the roll at each point. In other words, the section
will only appear once in the roll, but may be played as many times as required throughout the piece. The advantage
in using this technique is that a large amount of memory may be saved, but this is no longer necessary on modern
PCs. It is therefore preferable to form repeats by using F9 to copy the required section to the appropriate point.
The repeat then actually appears twice in the roll, and variations can be introduced as required. You can convert
your sectioned music to a continuous form by using the option on the Utilities menu.
The facility uses two of the commands briefly mentioned in the Editing Commands section: The J and D commands.
The D command allows the start and end of each repeat section to be Defined, and the J command allows you to
Jump to any repeat section from any point in the music. Repeat sections are all placed together at the very start of
the music roll. The start of each section is defined by placing a D command on the first line of the section. This
command must not be placed on a line containing music data, but as the start of each section would normally be
identified by at least one reference line, the D command would normally be placed on the same line as an R
command. If the D command is accidentally placed on a music line, all the holes in that line will be ignored.
There are no gaps between each of the repeat sections, therefore the end of each section is identified by the D
command at the start of the following section. The end of the last section, however, must be marked by a final D
command after the last line of the section (where the next section would start if there was one).
The main section of the music follows on after the last repeat section has been defined. As usual, it starts with an S
command and continues to the end of the roll. Under these circumstances, the S command no longer appears at the
top of the roll, but is still placed at the start of the main section of music. When repeat sections have been defined,
the ctrl+F3 command is automatically modified to place the S line after the end of the last section, rather than at the
top of the roll. The main section of the music would appear as normal, except that all of the repeated sections can
now be removed from the main section and replaced by a single jump command to the relevant section at the top of
the roll. J commands work in the same way as T commands, the number of dots on the J line corresponding to the
required section number. Sections number in ascending order, number 1 being at the top of the roll.
To clarify things, the whole system works like this: When the Editor plays or produces the music, it starts from the S
line and plays until it reaches a J command. If there are no J commands, the music will just play to the end, as
normal. Upon reaching a J command, it will find the section referred to in the J line and immediately jump to the start
of that section. This takes no time at all and any long slots will still remain continuous across the join. The repeat
section will now play out, and when the Editor encounters the end of the section, it will immediately return to the main
music at the position it was in before it made the jump. The main section now continues to play until either another J
command is encountered, or until the end of the roll is reached. So, once a repeat section has been defined, it may
be played any number of times, and at any position in the music by the addition of a single J command at the required
point. Taken to its extreme, the entire tune could be defined as a repeat section. The main section would then only
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consist of a short introduction, a J command to play the tune, possibly a bridge passage, and a second J command to
repeat the tune again.
You must be careful to adhere strictly to the above rules when programming repeat sections, otherwise unpredictable
results will occur. For instance, placing an S command in a repeat section is not allowed. Neither is placing a J
command in a repeat section, which would attempt to jump out of one repeat section into another. S and J
commands must be confined to the main section of the roll.
The Drum Advance feature may not work properly if there is a drum beat at the start of a section. Old music with
repeat sections can be converted into a continuous form by the option on the Utilities menu. This is recommended, as
there is no longer any advantage in using repeat sections, and they can be very confusing!

Importing MIDI Files
It is possible to import MIDI files into the Music Roll Editor by using the option on the Utilities Menu. The procedure
is generally straightforward, just follow the instructions on the screen.
Only MIDI type 0 files can be imported, and all the data must be on channel 1. If necessary, you can use a 'normal'
MIDI editor to move the required data to channel 1, and then save it as a type 0 file.
Choosing the Import Scale
For your reference, the Editor reads the MIDI file and lists all the notes that it finds there, along with their MIDI
numbers. You can decide where you want to place each of these notes on the music roll. When the Editor imports
the MIDI file, it uses the Scale Configuration file in reverse, to put the MIDI notes onto the Editor keys. Therefore
you can use the same Configuration file to transfer MIDI notes into the Editor as you use to generate those same
MIDI files from the Editor. In other words, the same scale will transfer the information both ways: Editor to MIDI
file; MIDI file to Editor. You can either load the scale in beforehand, or from the Import screen. A special scale has
also been provided for you to load the MIDI notes 1 to 64 onto keys 1 to 64. After the MIDI file has been read,
you will be warned if there were any illegal notes in the file that couldn't be imported because they were out of range.
(A single example is also given.)
Choosing the Import Resolution
The fastest repetition rate that most organs can manage is 10 notes per second (1/20th second ON followed by
1/20th second OFF). This is why the Music Roll Editor has a fastest frame-rate of 20 frames per second. This is the
fastest rate required for organ music, and it also ensures that everything written using the Music Roll Editor will play
properly on the organ (unless it is out of adjustment). Unfortunately, the MIDI system allows for music to be written
at a much faster rate than 10 notes per second. This is fair enough, but it does pose problems when trying to import
MIDI files into the Editor. You will often find that the MIDI file will need a certain amount of cleaning up after
importation, and very short notes of less than 1/20th second may not appear at all.
The program reads the MIDI data by sampling it at regular intervals, and storing each sample in a single frame across
the screen. As these frames normally represent 1/20th of a second intervals, it is important that the music should be
sampled at the correct resolution, to avoid timing errors and missing notes. You can adjust the resolution to suit the
tempo of the music, and the number of frames that you want each note to occupy. The program will calculate the
optimum resolution based on these requirements. Alternatively, you can specify your own frames-per-second rate, if
you know what you want. If you do not get the desired result the first time, remember that to increase the length of
the notes on the screen, increase the resolution (and vice versa).
Importing in High-Speed Mode
You can avoid all timing and sampling errors by importing the music in High-Speed mode. This is the reason why
this mode was provided, as it is not used when creating music on the Editor (or shouldn't be!). In High-Speed mode,
the frame rate can be as fast as 100 frames per second, which is more than adequate for any MIDI file that you may
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wish to import. Unfortunately, there are disadvantages in using the High-Speed mode. The main disadvantage is that
it is difficult to edit the music on the screen, because each note will be very long, especially if you use the 100
frames/second speed! At this speed, a note of 1 second duration will be 100 frames long, which will occupy more
than the whole screen! In practice, you would only use such a fast rate if you wanted to import a tune into the Editor
as accurately as possible, but didn't need to edit it. If you want to use the High-Speed mode, any rate between about
30 to 50 frames per second should be suitable for importing most music. The other disadvantage in using the
High-Speed mode is that you must be very careful not to exceed the organ's repetition rate. Organs cannot be
expected to play faster than 10 notes per second, so in theory, all notes in the music (and all gaps between notes)
should be at least 2 frames long when using the High-Speed mode, especially if running at over 26 frames/second (13
notes per second). After importing the music in High-Speed mode you could use the Halve the Frame Resolution
option on the Options menu to gradually reduce the resolution until the shortest note occupies a single frame.
Preparing the MIDI file
As mentioned above, the MIDI file must be type 0, and on channel 1. You should check that there are no
overlapping or duplicate notes in the music. These are caused by a note switching on twice before it switches off
again. In all cases the percussion channel (channel 10) should normally be disabled, as this will cause spurious notes
to be read in the middle of the roll. Do not try to import a full orchestral score into the Editor, expecting it to fit all the
notes from 16 instruments onto a 20-note music roll! Piano music is usually the easiest to import, as it is usually all on
a single track with no duplicate notes. Obviously, any notes that are not on the organ scale will not be imported.
These will not cause an error, they will just be ignored.
When the music has been imported, there will be a short pause after which the music will be played. Pressing any
key will take you back to the Editing screen, where you will be able to see the imported music, edit it, and save it,
etc.
Unexpected Errors
Because there are some obscure aspects of MIDI which are not catered for by the Music Roll Editor (and not
needed for organ music) you may get some unexpected errors when trying to import some complex MIDI files.
These are given error numbers. If this happens, contact me and I will try and sort it out.

Importing Harmonist Files
As almost all Harmonist files were originally written using this Editor program, they can be imported directly without
any of the difficulties encountered with MIDI. They should appear on the screen exactly as written, except that
R-lines are not programmed into the chip, so they will not appear. No support is provided for Harmonist-1 music. I
think almost all Harmonist-1 organs have been upgraded long ago (or are rotting away in barns somewhere!)
You will need to load a suitable Harmonist scale before attempting to import Harmonist music. This is the same scale
that was used to produce the Harmonist file. Any Harmonist scale will do, as long as it contains all the notes that
appear in the Harmonist file.

Customised Sounds
As the Scale Configuration file contains information about the pipework and volume of each register in the organ, the
potential for customisation is enormous. It is possible to have a separate Configuration file for each individual organ,
rather than each scale of organ. This means that two organ configurations could sound totally different, even though
the scale is identical. This is a useful facility, as different organ builders use different pipework for organs using the
same scale. For instance, early Dean organs tended to use large scale Flutes, which were actually louder than the
Violins! Therefore, in these organs the Violins are used for piano passages, and the Flutes for forte. This is the
opposite to normal, but it is a simple matter to change the volume of the pipes in the Configuration file to match the
balance of each organ.
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MIDI Voice Allocation
The program uses 8 MIDI channels to play the organ music on the computer sound card, as follows:
Channel No.

Register Name

Channel 1
Channel 2
Channel 3
Channel 4
Channel 5
Channel 6
Channel 9
Channel 10

Flutes
Bourdons
Violins/Cellos
Glockenspiel
Piccolos
Trumpets/Trombones
Bass Helpers
Percussion

MIDI Voice
No.
79
80
70
10
73
59
79 (fixed)
n/a

MIDI Voice Name
Whistle
Ocarina
English Horn
Glockenspiel
Piccolo
Tuba
Whistle
n/a

The register names and the voices used are purely arbitrary and you can use any voice you like on channels 1 to 6.
For instance, the Violin register key switches on channel 3, but if you installed a clarinet voice on channel 3, the Violin
register would then become a Clarinet register! Therefore you are not limited to the 6 registers provided, you can
have any sound you like on each of the registers, limited only by the capabilities of your sound card.
This facility also allows you to select the most realistic voices from your sound card. Although General MIDI
equipment has 128 voices to cover virtually every instrument in the world, it will come as no surprise to you that none
of these voices sounds very much like a fair organ! Of course, the voices labelled 'Flute', 'Violin', and 'Trumpet' are
meant to sound like orchestral instruments, so you can't really expect them to sound like the fair organ versions.
When I chose the voices to use for the various 'Pipework' I chose those which sounded the best on my sound card at
the time. Your MIDI equipment will probably sound totally different from mine, so you have the facility of choosing
your own voices to represent each rank of pipes. For instance, some people use the Pan Flute sound (76) to
represent Bourdon pipes. The only reason I didn't use this is because the Pan Flute sound on my sound card has
quite a slow attack so it doesn't play fast passages very well. Yours may well be different.
The sounds that you can produce with the MIDI system and the Music Roll Editor are limited only by your
imagination. You have the entire General MIDI instrument set to work with, and each voice can be adjusted in
volume relative to the others, to achieve some very subtle effects. In addition, if your equipment allows you to use
sampled sounds (most do) you should be able to achieve just about anything!
Register Volume Levels and Balance
The main purpose of the volume adjustment is to allow you to alter the balance between the registers on the organ,
but it also allows you to compensate for differences in your sound card and speaker levels. The values that you enter
for the volume are 1 (quiet) to 10 (loud). You should normally choose a value around 5, except for pipework which
is very loud or very soft. This is not a master volume control, so do not enter all levels of 10 just to make the organ
louder! You can make the organ louder by turning up the volume on your computer. The volume of the percussion
and the Bass Helpers is adjustable from the Options menu, but if you have set the register volumes too high it may be
difficult to hear the drums, even on their loudest setting. Conversely, if you want the drums to be nice and loud, turn
down the volume of the registers.
When setting up a scale for an organ with a lot of Melody registers, you will probably find that the Accompaniment is
swamped out during Forte passages with all registers on. You can increase the volume of the Accompaniment by
using Fixed Registers of Flutes and Bourdons instead of just Flutes, even though the organ may not have Bourdons
on the Accompaniment. Of course, if you want to be strictly accurate you can always have two ranks of Flutes by
changing the voice of a spare channel to Flutes and connecting both channels to the Accompaniment as Fixed
Registers. On the whole, I find that identical voices used together are not very effective. It is better to use slightly
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different voices for a fuller effect. This is particularly relevant to Counter-Melody voices. Because the
Counter-Melody section plays on the same notes as the Accompaniment and Melody sections, you will get a much
clearer effect if you use a different voice for the Counter-Melody.
Another trick to achieve a better Accompaniment balance is to use register number 208 instead of 213 for the Violin
register. This register connects Violins/Cellos to both the Melody and the Accompaniment, instead of just the
Melody, so that a better balance is maintained.

Some Useful Tips
When you are moving or copying a section with the F8 or F9 commands, don't try to get it in exactly the right
position straight away. Create a number of blank frames at the position (just press Enter a few times) transfer the
section to the centre of the blank frames, then delete the blank frames one-by-one until the new section fits in exactly
with the timing marks.
When working on the Bass and Accompaniment sections, which have a regular rhythm, consult the timing marks
above the one on which you are entering the notes. These should line up with the previous beats in the music, and it
is often easier to determine the position of the new holes by reference to these marks.
There is no Undo facility (not yet anyway) so it is a good idea to save the music before using an F7, F8, or F9
command, in case you make a mistake. You can also save to disk whenever you are about to add something to the
music, and you are not quite sure what the result will sound like. If the result is unacceptable, the original can easily
be restored.
Simple transposition can be accomplished using the Scale Conversion utility.
After using the Editor for a while, you may come across what appears to be a problem with holes whose lengths do
not correspond to an exact number of frames. For instance, what happens if you need to fit 3 notes of equal length
into a distance of 4 frames? There are two ways around this problem (apart from using the High Speed mode): The
easy way is to cheat, by making one of the notes longer than the rest, to fill in the gap. The other way involves
temporarily changing the tempo of the music so that the frames fit in with the required notes exactly. Experience has
shown that it is hardly ever necessary to have to change the tempo to accommodate irregular length notes, the
'cheating' method being quite acceptable. Rather surprisingly (and fortunately) the artificially lengthened or shortened
notes are almost always completely undetectable by ear, but you may have to experiment to find which is the best
note to lengthen or shorten.
This technique is the most useful when adding waterfalls to a passage (in the mechanical organ world, long runs up or
down the scale are known as 'Waterfalls'). It is most unlikely that the waterfall will fit exactly in the space required.
The first trick to overcome this problem is to try to alter the number of notes in the waterfall so as to make them fit
exactly into the available space. Adding or subtracting a sharp note here and there will not be noticed, neither will the
lengthening or shortening of single notes, provided they are carefully chosen.
In extreme cases, it may be necessary to change the tempo of the music to accommodate these irregular length notes
exactly. This is no great problem, although it does make the roll look rather messy on the screen at that position, and
the notes will not line up with the timing marks because of the extra Tempo commands. As an example, supposing
the music is running at a tempo of 20 and you find that you are required to fit in 2 notes in the space of 3 frames. The
problem is that the existing frames are too short to accommodate the division exactly, you need a division exactly
mid-way along the 3 frames, ie: 1.5 frames. Lengthening the frames is accomplished by slowing down the tempo, in
this case by 1.5 times. Therefore, if the tempo is changed to 30 the 2 notes will now fit exactly on 1 frame each. If
done correctly, the tempo change will be completely invisible during playback, you will just hear the notes in their
correct positions.
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Possible Problems
Here are some of the possible problems you might encounter when using the Music Roll Editor:
I bought the Full Version of the Editor, but now I only see the Trial Version
Make sure that you have the "Upgrade.key" file in the same folder as the "MusicRollEditor.exe" file. The Editor looks
for this file when it starts up. If it can't find it, it might be missing from the folder or spelt wrongly. If you have lost it,
contact me for a replacement.
Program runs too slowly
As mentioned in the System Requirements section, this should not be a problem if you have a fairly modern PC, even
a basic one. If you find that the program runs too slowly, decrease the screen size (from the Options menu) and
make sure that you are using as narrow a music width as possible. Sometimes, the speed of the keyboard can also
cause a delayed response to the keys. You can fix this by going into the Control Panel / Keyboard section, and
adjusting the keyboard delay and repeat rate.
Music Doesn't Sound Very Realistic
This is because you haven't selected the appropriate MIDI voices to suit your own sound card. The voices that I
used in the scales supplied are the best that I could select from the standard voices in my sound card. Other cards
won't sound exactly the same as this, and you may need to change some or all of the voices to achieve a realistic
sound. One observation I have made is that the more expensive external sound modules do not sound anything like
as good as the humble PC sound card! The reason for this is that the sounds are probably too accurate to be used
for anything other than the instruments they are supposed to represent. It doesn't do to buy an expensive sound
module unless you want an accurate representation of an orchestra. A low-cost sound card will probably give you a
better fair organ sound, although you may have to experiment with the voice numbers to find the most effective voices
to use.
Duplicate Notes Being Cut Short
If the notes in two separate sections of the organ overlap each other (as in the case of a Counter-Melody section
overlapping the Melody section) and these notes are playing on the same pipework; there will be instances when both
Melody and Counter-Melody sections operate the same note on the same channel. This does not matter, but a
problem may arise when the note is switched off. If the notes are of different lengths, one of the notes may be cut
short because the note might be switched off when it receives the first NOTE OFF command. In practice, this does
not pose any major problem because it only applies to the Counter-Melody section, and this section usually has
different pipework from the other sections of the organ, so the problem doesn't arise. Even if the pipework is the
same, the Melody will usually be playing on more than one rank of pipes, so the shortened note may be covered up
by the extra ranks.
The problem can be overcome completely by using different channel numbers for overlapping sections. All of my
supplied scales use different channel numbers on Counter-Melody. Don't forget that you can install any voice on any
of the six channels, so you could have two separate Flute channels. For instance, if both the Melody and
Counter-Melody are on Flutes and you don't need the Piccolos, you could install a second Flute voice (79) on the
Piccolo channel (channel 5). Whenever you want to select the Melody Flutes, you just select the Piccolos instead
(which now sound like Flutes!). In practice, you will get a better effect if you do not use identical voices in
overlapping sections, so you should use a slightly different Flute sound for the second rank of Flutes. On German
organs with Trumpets both on Melody and Counter-Melody, the Glockenspiel channel could be used as a second
Trumpet rank to avoid duplication of notes.
The Bass Notes Aren't Working
This is almost certainly caused by the poor Bass response of your speakers. When I first played my music through
my MIDI sound card, I couldn't understand why the Bass notes weren't working. I discovered that they were
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working - I just couldn't hear them! The Bass Flutes were barely audible over the rest of the organ. This is the
reason why I included Bass helpers an octave higher to duplicate the Bass notes. I have also increased the internal
volume of the Bass and the Accompaniment sections compared to the rest of the organ. However, even with these
enhancements, the Bass notes will not be as prominent as they should be if you are only using small speakers. The
solution is to connect up your MIDI equipment to your hi-fi set, or to invest in a good sub-woofer speaker system, or
possibly use headphones.
Outputting MIDI Note 0
When you enter the numbers into the Organ Key Table, you will remember that if you enter a zero for any key, that
note is ignored. This is no problem for conventional organs as the keys always number from 1 and there is no such
thing as key 0. But it could be a problem with some MIDI organs, as MIDI note numbers go from 0 to 127.
Therefore, this means that when writing music for MIDI organs you cannot direct any key onto MIDI note number
zero, as it will be ignored. In practice, you are never likely to use MIDI note zero. I have only ever encountered it
once and what I did was to add a 1 to every MIDI number in the Key Table, so note zero went to note 1, note 1
went to note 2, etc. Then I used the option to produce a transposed MIDI File and simply transposed it down by 1
semitone, so that all the keys were back in their correct positions - including note zero.
Using the new PC version of the Editor with Existing Music
The Editor will work with existing music, but it is now stored differently on disk. Whereas previously there was a .cfg
and a .mus file for each piece of music, there is now only a .mus file, which contains the .cfg file within it. The
program will automatically convert your old files to the new format. To do this, first load in a suitable .cfg file for your
music (ctrl+F11); then load the .mus file (ctrl+F12). You should see your music come up on the screen. If it is
garbled, then you have loaded the wrong .cfg file! Now save your music as normal. You are advised to do this as
soon as possible, as future editions of the program are unlikely to contain all the conversion routines.
Because of the vast amount of memory now available, I would also advise that you use the option on the Utilities
menu to convert any sectioned music to a continuous form; and the Append Complete Music Roll option on the File
menu to join separate rolls together where they may have been originally saved as multiple files (part1, part2, etc.).
You will also need to add the title and copyright information on the Properties screen, using the File menu or the
Insert menu.
Drum advance and automatic detection of drum rolls has now been included, but this should not affect your existing
music, as these new features do not need to be used. All side drum holes are now placed on the Drum Roll key and
the Single-Stroke key is no longer needed. Existing music which uses the Single-Stroke key will still work as before
- the two keys are now identical. See Percussion section for more details.
If you have music which contains drum beats which were placed ahead of the beat, this is now no longer necessary.
You can define up to two keys which will have an automatic 1-frame advance applied to them. This is defined in the
.cfg file, but if you continue to use your existing .cfg files, then no advance will be applied and your music will not be
affected. For new music, you can choose to either continue as before, or use a new .cfg file and remove the
advances from your music. For your convenience, the Properties screen will tell you whether any drum advance is
programmed into the .cfg file or not; so that you can write your music to suit.
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Ready-Made Scales Supplied
To assist you in devising your own scales, here are some notes about the scales that are supplied with the program.
The voices in these scales are tailored to my sound card, and you may want to change the voice numbers to sound
better on your own MIDI equipment. Use this page in conjunction with the numbers in the percussion and register
sections.
20noteRollScale.cfg
This is the common 20-note paper roll scale used by Raffin and many other builders. A straight-forward scale with
no registers. The Melody plays on Bourdons.
20noteJSmithScale.cfg
This is the 20-note paper roll scale used in the John Smith and Castlewood organs. Musically the same as above but
with different paper dimensions, and I have tuned the scale to the actual pipe pitches, to avoid confusion. As there is
only one pipe per note, the Melody plays on Flutes rather than Bourdons.
21noteHarmonetteScale.cfg
This is the Pell Harmonette and Mini-20 scale, and has fixed Flutes throughout, plus a bell.
22keylessScale.cfg
This is the English cardboard book scale, used by Dean, Trueman, McCarthy and others. This scale also has fixed
pipework. Because some of these organs are fair organs, I have chosen to use soft Violins on the Melody section;
but you could just as easily use Bourdons. In fact you could have a street organ scale with Bourdons and a bell; and
a fair organ scale with Violins and a drum, both playing the same music files.
26noteRollScale.cfg
This is the 26-note scale used by the John Smith Universal, Jaeger & Brommer, and others. It is an extension of the
20-note roll scale. Because most of these organs have sliders, I have used Violins and Bourdons for the Melody.
Note that, although the scale on the organ is partially scrambled with all the sharps at one end, this doesn't affect the
layout on the screen, which is straight.
30-33keyHarmonistScale.cfg
This is the 30-33 key Harmonist scale, with Bourdon, Violin, and Glockenspiel registers. The Bass and
Accompaniment play on Flutes, and there is no fixed pipework on the Melody. As on all Harmonist scales, there is a
single drum-roll key, and a bass drum and cymbal. No automatic drum roll is produced, as it is provided by the
organ.
30-33keyHarmidiScale.cfg
The same as above, except that it produces MIDI files instead of Harmonist music. Harmidi organs have the side
drums connected to individual MIDI numbers, so no internal drum roll. The drum roll is provided by the Editor.
31noteRollScale.cfg
This is the common 31-note paper roll scale used by Raffin, Pell and others. Another simple roll scale with no
registers. These organs are usually provided with an assortment of sliders, including Piccolos and sometimes
Trumpets. However, I have only included Violins and Bourdons on the Melody, as the music wouldn't sound right if
the Piccolos and Trumpets were permanently switched on. This scale has a spare key (?) at the end which has been
used for various purposes. Although the key does nothing in the Editor, it is brought out to note 32 on the paper roll.
31keylessScale.cfg
The common 31-keyless book scale, sometimes attributed to Chiappa. This is the scale that uses the bass drum to
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switch on the Forte register, as already mentioned in the Percussion section. The Melody has fixed pipework of
Flutes, which are augmented by Violins and Glockenspiel when the Forte register is selected. This is achieved by
keys 132 and 202. Key 202 is a high-priority Cancel key, so it will keep the Forte register switched off if it is
operated along with the drum, just as on the organ. Note that not only has the bass drum key been advanced, but the
Cancel key has also had to be advanced, as both keys work together to operate the register.
31keylessTruemanScale.cfg
This is a variation of the above scale. In these organs, the bass drum switches the Bourdons over to Violins. A
separate key is provided to select a Glockenspiel. Both the Violins and the Glockenspiel are cancelled by the
Piano/Override key. An additional complication is that the side drum is switched over to wood blocks when the
Bourdons are selected. All of this can be simulated by the Editor. The bass drum is taken to key 133, which
switches the Violins on and the Bourdons off. The Glockenspiel key is taken to the normal Glockenspiel register
209. The Piano key operates register 226, which switches the Bourdons on and both the Violins and Glockenspiel
off. Finally the side drum key is taken to key 143 to switch the wood blocks on with the Bourdons.
42keylessBruderScale.cfg
An interesting scale as it has two separate Bass sections: Flutes and Trombones. Because both of these sections play
on the same notes, the Trombones are placed on the Counter-Melody, which plays on fixed Trombones and Flutes.
The Accompaniment and Melody play on fixed Violins. There is a single set/cancel register that provides the
German crash Forte. This is achieved by register No.215 and cancelled by register 231.
48keyGavioliScale.cfg
The common 46-48 key Gavioli scale. A single set/cancel register adds a simple Forte of Violins and Glockenspiel
to the Melody. I have also coupled the Cymbal to the Violin register, mainly to show how it is done, using key 144.
Note that this scale has a 2-key side drum mechanism, but only 1 key is necessary on the screen. There are some
Bruders that were converted by Chiappa to play 48 key music. These organs are best imitated by using the German
Forte key 215 instead of key 212 as the Forte key.
49-52keyHarmonistScale.cfg
This is the Pell 49-52 key Harmonist scale. Like the 30-key Harmonist scale with the addition of a Flute register.
Note that the c#-d# tremulant isn't provided as it is a virtual register with no separate key. If required, you could
provide a separate key to work the Tremulant (251) and connect it to key No.0 so that it is ignored when the music
is produced.
49-52keyHarmidiScale.cfg
The same as above, except that it produces MIDI files instead of Harmonist music. Harmidi organs have the side
drums connected to individual MIDI numbers, so no internal drum roll. The drum roll is provided by the Editor.
54keylessDeanScale.cfg
This is an extension of the 48-key Gavioli scale, with Declanche type registers of Violin, Flute, Bourdon, Cello,
Glockenspiel, and Trombones on the Bass. Register 203 provides the Bass Trombones, while the spare Piccolo
register has been used for the Cello register, by changing the Piccolo voice from 73 to 71. This scale uses separate
bass drum and cymbal keys, connected to 128 and 129, and side drum key 143 which switches the side drums over
to wood blocks when the Bourdons are selected.
65keyHarmonistScale.cfg
This is the German version of the 65-key Harmonist scale (actually 63 keys). Similar to the 49 key scale, but with
the addition of a Counter-Melody section, and a Piccolo register on the Melody. The Counter-Melody is normally
on Flutes, but register key 216 is provided to switch the Trumpets on. Note that all the register keys are
self-cancelling, so if any Melody register is selected, the Counter-Melody will be switched back to Flutes again unless key 216 is operated at the same time. To enable the Counter-Melody to sing out over the 4 Melody registers,
the Trumpets and Flutes are given maximum volume, whilst the Melody registers are set at half volume. There is no
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problem with using duplicate voices for the Melody and Counter-Melody here, because there are no common
registers between the two.
65keyHarmidiScale.cfg
The same as above, except that it produces MIDI files instead of Harmonist music. Harmidi organs have the side
drums connected to individual MIDI numbers, so no internal drum roll. The drum roll is provided by the Editor.

Created with the Freeware Edition of HelpNDoc: Easy CHM and documentation editor

MIDI
History
The Musical Instrument Digital Interface MIDI (always capitalised) has revolutionised the music industry since its
introduction in 1983. At that time, MIDI was simply a means of connecting together synthesisers from different
manufacturers so that musical commands could be sent from one instrument to another. In this way, a player could
control a number of instruments from a single keyboard. Towards the end of the 80s, computers were being fitted
with MIDI interfaces. With suitable software, musical data could be stored in the computer and fed to a number of
instruments connected to the computer's MIDI port. This enabled these instruments to be played entirely
automatically by the computer - The mechanical musical instrument was reborn!
At this time, it was usual for instruments to be able to play just a single voice, and sometimes only a single note at a
time. Therefore, a large number of separate instruments usually had to be connected up in order to produce the
effect of a decent sized band or orchestra. In the mid 80s when I first designed my Music Roll Editor, MIDI
equipment was extremely expensive and very primitive by today's standards. It was intended to be used by stage
musicians, and only fitted on high-end professional equipment. I found it far easier and cheaper to design my own
instrument and tailor it to my exact needs than to use the MIDI system. Furthermore, home computers were not
fitted with a MIDI interface, so there was no benefit in using MIDI, in fact quite the reverse.
Now, however, things have changed completely. MIDI equipment is very cheap, and extremely powerful. Almost
every PC comes with a MIDI sound card fitted inside it, so it is not even necessary to buy any separate MIDI
equipment. Most of these sound cards can play a minimum of 24 notes on each of sixteen instruments
simultaneously, so can easily imitate the sound of a full orchestra. If that's not enough, they also have a built-in MIDI
interface so that you can connect up further sound modules!
In the early 90s, the MIDI system was further enhanced with the introduction of Standard MIDI Files and the
General MIDI specification. Until that time it was not possible to exchange musical data from one computer system
to another, unless both computers were the same and were also running identical software. The original MIDI system
only defined the way in which electronic signals were transmitted along the cables to control the various instruments.
In 1991 the Standard MIDI File was introduced, which defined the way in which the musical data should be stored
on a computer disk, so that a disk from one computer could be read by another computer; even though both systems
were using entirely different sequencing programs. Not only did this make it possible to transport musical data
between computers, it also enabled musicians to record and publish their compositions in Standard MIDI File (SMF)
format. Any MIDI sequencer would be able to read the disk, and send the MIDI data to its sound card, thereby
recreating the original performance. The General MIDI specification standardised the instrument voices and their
patch numbers. Before General MIDI, instruments from different manufacturers would have a different table of
sounds, so that voice number 1 on one instrument might be a violin, and voice number 1 on another instrument might
be a piano. This obviously led to some unpredictable results when connecting together instruments from different
manufacturers! Equipment conforming to the General MIDI standard now has a basic set of 128 voices which will
sound roughly the same as those from other manufacturers. The drum set has also been standardised.
MIDI Channels
The MIDI system uses a serial interface to transmit data from one piece of equipment to another. Although the
cables contain 5 wires, only 2 of them are used for communication. Data from one instrument is sent out of that
instrument's MIDI OUT socket, which is connected to the receiving instrument's MIDI IN socket. A third socket is
often provided called MIDI THRU. The THRU socket transmits an exact copy of the data arriving at the MIDI IN
socket, and is used to daisy-chain a number of instruments together on the same system.
Although each instrument in the chain will receive exactly the same MIDI information, it is possible to direct messages
to specific instruments, using the concept of MIDI Channels. Messages sent along the MIDI highway can be coded
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with a channel number. Instruments connected in the chain will receive every message on every channel, but they can
be programmed to respond only to messages on a particular channel, or to respond differently to messages on certain
channels.
MIDI Messages
There are a large number of message types supported by the MIDI system, but only a few are applicable to
mechanical organs and my Music Roll Editor:
RESET
This message resets all equipment to its power-up state.
NOTE ON and NOTE OFF
These are the most important messages used by MIDI. Each of these two messages is followed by a pitch number
from 0 to 127, and a volume (called velocity) number from 1 to 127. It therefore follows that there are 128 different
pitches of note available, and 127 volume levels from the softest (1) to the loudest (127). A volume level of zero
actually switches the note off. Some keyboards are not able to sense the velocity of the keys as they are pressed, so
they transmit a volume level of 64 which is the half-way value.
The note pitches are arranged in exact semitone intervals, starting from 0 which is C-2 to 127 which is G8, as in the
following table:

C-2
C-1
C0
C1
C2
midC
C4
C5
C6
C7
C8

C
0
12
24
36
48
60
72
84
96
108
120

C#
1
13
25
37
49
61
73
85
97
109
121

Table of MIDI Note Numbers (from 0 to 127)
D
D#
E
F
F#
G
G#
2
3
4
5
6
7
8
14
15
16
17
18
19
20
26
27
28
29
30
31
32
38
39
40
41
42
43
44
50
51
52
53
54
55
56
62
63
64
65
66
67
68
74
75
76
77
78
79
80
86
87
88
89
90
91
92
98
99
100
101
102
103
104
110
111
112
113
114
115
116
122
123
124
125
126
127

A
9
21
33
45
57
69
81
93
105
117

A#
10
22
34
46
58
70
82
94
106
118

B
11
23
35
47
59
71
83
95
107
119

ALL NOTES OFF
This message switches all notes off on a particular channel. This useful facility is not implemented on every MIDI
instrument, but it is provided on General MIDI equipment.
CONTROL CHANGE
Control Change messages refer to the various switches, wheels and pedals on an instrument. Each control has a
number associated with it, and similar types of controllers are grouped together. Controller numbers 0 to 63 are used
for continuously variable controls. Numbers 64 to 95 are used for variable controls and switches. Numbers 96 and
97 are used for data increment and decrement buttons. Number 121 is used for resetting all controllers, and numbers
122 to 127 are used for MIDI mode changes. The only controller used by the Music Roll Editor is the Modulation
Wheel, which is controller number 1.
PROGRAM CHANGE
Program Change messages are equivalent to registers on an organ, and are used to change the voices of an
instrument. General MIDI equipment has a standard set of 128 voices, as set out in the following table. Each of the
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sixteen channels (or as many channels as required) would normally be switched to a different instrument, thereby
allowing sixteen instruments to be played at once. Using Program Changes throughout a piece of music makes it
possible to use dozens of sounds on each channel, if necessary.
Table Of General MIDI Instrument Voice Numbers (from 1 to 128)
Prog No. Instrument
Prog.No Instrument
Piano
Tuned Percussion
1
Grand Piano
9
Celesta
2
Bright Piano
10
Glockenspiel
3
Electric Grand
11
Music Box
4
Honky-Tonk
12
Vibraphone
5
Electric Piano 1
13
Marimba
6
Electric Piano 2
14
Xylophone
7
Harpsichord
15
Tubular Bells
8
Clavinet
16
Dulcimer
Organ
Guitar
17
Drawbar Organ
25
Acoustic - Nylon
18
Percussive Organ
26
Acoustic - Steel
19
Rock Organ
27
Electric - Jazz
20
Church Organ
28
Electric - Clean
21
Reed Organ
29
Electric - Muted
22
Accordion
30
Overdriven Guitar
23
Harmonica
31
Distortion Guitar
24
Tango Accordion
32
Guitar Harmonics
Bass
Strings
33
Acoustic Bass
41
Violin
34
Electric - Finger
42
Viola
35
Electric - Pick
43
Cello
36
Fretless Bass
44
Contrabass
37
Slap Bass 1
45
Tremolo Strings
38
Slap Bass 2
46
Pizzicato Strings
39
Synth Bass 1
47
Orchestral Strings
40
Synth Bass 2
48
Timpani
Ensemble
Brass
49
String Ensemble 1
57
Trumpet
50
String Ensemble 2
58
Trombone
51
Synth Strings 1
59
Tuba
52
Synth Strings 2
60
Muted Trumpet
53
Choir Aahs
61
French Horn
54
Choir Oohs
62
Brass Section
55
Synth Voice
63
Synth Brass 1
56
Orchestra Hit
64
Synth Brass 2
Reed
Pipe
65
Soprano Sax
73
Piccolo
66
Alto Sax
74
Flute
67
Tenor Sax
75
Recorder
68
Baritone Sax
76
Pan Flute
69
Oboe
77
Blown Bottle
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70
71
72
81
82
83
84
85
86
87
88
97
98
99
100
101
102
103
104
113
114
115
116
117
118
119
120

English Horn
Bassoon
Clarinet
Synth Lead
1 - Square
2 - Sawtooth
3 - Calliope
4 - Chiff
5 - Charang
6 - Voice
7 - Fifths
8 - Bass & Lead
Synth
FX1 - Rain
FX2 - Soundtrack
FX3 - Crystal
FX4 - Atmosphere
FX5 - Brightness
FX6 - Goblins
FX7 - Echoes
FX8 - Sci-Fi
Percussive
Tinkle Bell
Agogo
Steel Drums
Woodblock
Taiko Drum
Melodic Tom
Synth Drum
Reverse Cymbal

78
79
80
89
90
91
92
93
94
95
96
105
106
107
108
109
110
111
112
121
122
123
124
125
126
127
128

Skakuhachi
Whistle
Ocarina
Synth Pad
1 - New-Age
2 - Warm
3 - Polysynth
4 - Choir
5 - Bowed
6 - Metallic
7 - Halo
8 - Sweep
Ethnic
Sitar
Banjo
Shamisen
Koto
Kalimba
Bagpipe
Fiddle
Shanai
Sound Effects
Guitar Fret Noise
Breath Noise
Seashore
Bird Tweet
Telephone Ring
Helicopter
Applause
Gunshot

Percussion
MIDI channel 10 is specially reserved for percussion effects. This channel works in a different way from the other
channels. In normal circumstances, channel 10 does not have access to the table of instruments listed above.
Instead, each of the 128 notes on the channel works a different percussion effect. In practice, only 47 of the possible
128 notes are specified by General MIDI, as follows:
Table
Note No.
35
36
37
38
39
40
41
42

Of General MIDI Percussion Instruments (from 35 to 81)
Drum Sound
Note No. Drum Sound
Acoustic Bass Drum
59
Ride Cymbal 2
Bass Drum 1
60
High Bongo
Side Stick
61
Low Bongo
Acoustic Snare
62
Mute High Conga
Hand Clap
63
Open High Conga
Electric Snare
64
Low Conga
Low Floor Tom
65
High Timbale
Closed Hi-Hat
66
Low Timbale
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43
44
45
46
47
48
49
50
51
52
53
54
55
56
57
58

High Floor Tom
Pedal Hi-Hat
Low Tom
Open Hi-Hat
Low-Mid Tom
Hi-Mid Tom
Crash Cymbal 1
High Tom
Ride Cymbal 1
Chinese Cymbal
Ride Bell
Tambourine
Splash Cymbal
Cowbell
Crash Cymbal 2
Vibraslap

67
68
69
70
71
72
73
74
75
76
77
78
79
80
81

High Agogo
Low Agogo
Cabasa
Maracas
Short Whistle
Long Whistle
Short Guiro
Long Guiro
Claves
High Wood Block
Low Wood Block
Mute Cuica
Open Cuica
Mute Triangle
Open Triangle

There is no provision for a Drum Roll sound.
SYSTEM EXCLUSIVE
System Exclusive messages are unique to a particular manufacturer, and can perform any function.
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